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License Agreement
READ CAREFULLY BEFORE INSTALLING THE MINISOFT SOFTWARE APPLICATION:
CUSTOMER: THE MINISOFT SOFTWARE APPLICATION ("PRODUCT") THAT YOU PURCHASED CONTAINS COPYRIGHTS, TRADE SECRETS, TRADE MARKS, AND OTHER INTELLECTUAL PROPERTY RIGHTS BELONGING TO MINISOFT, INC. ("MINISOFT"), HAVING
ITS PRINCIPAL OFFICES LOCATED AT 1024 FIRST STREET, SNOHOMISH, WASHINGTON, 98290, U.S.A. THE PRODUCT MAY BE INSTALLED, COPIED, DISPLAYED, EXECUTED, PERFORMED, OR USED IN ANY OTHER FASHION ONLY IN ACCORDANCE WITH THE
TERMS OF THIS LICENSE AGREEMENT ("AGREEMENT" OR "LICENSE"). THE TERMS "YOU" OR "YOURS" ARE SOMETIMES USED
HEREIN AND MEAN RESPECTIVELY CUSTOMER OR CUSTOMER'S. SOMETIMES EACH OF MINISOFT AND CUSTOMER IS REFERRED
TO HEREIN AS A "PARTY," AND SOMETIMES THEY ARE COLLECTIVELY REFERRED TO AS THE "PARTIES." YOU MAY NOT INSTALL,
COPY, DISPLAY, EXECUTE, PERFORM OR USE IN ANY OTHER FASHION THE PRODUCT EXCEPT IN ACCORDANCE WITH THE TERMS
AND CONDITIONS OF THIS AGREEMENT. IF YOU INSTALL, COPY, DISPLAY, EXECUTE, PERFORM OR OTHERWISE USE ANY PART OF
THE PRODUCT, YOU ARE DEEMED TO HAVE ACCEPTED AND YOU ARE BOUND BY ALL THE TERMS AND CONDITIONS OF THIS
MINISOFT LICENSE AGREEMENT ("AGREEMENT"). IN ORDER TO USE THE PRODUCT, YOU MAY BE REQUIRED TO OBTAIN A UNIQUE
CODE OR CODES FROM MINISOFT TO ENABLE INSTALLATION, COPYING, DISPLAY, EXECUTION, PERFORMANCE AND OTHER USE
OF THE SOFTWARE PRODUCT. IF YOU DO NOT ACCEPT AND AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, YOU
ARE PROHIBITED FROM INSTALLING, COPYING, DISPLAYING, EXECUTING, PERFORMING, OR USING IN ANY OTHER FASHION THE
PRODUCT. VIOLATION OF THIS AGREEMENT (1) CONSTITUTES INFRINGEMENT, MISAPPROPRIATION AND CONVERSION OF
MINISOFT'S COPYRIGHTS, TRADE SECRETS, AND OTHER INTELLECTUAL PROPERTY RIGHTS, (2) WILL SUBJECT THE INFRINGER
TO SIGNIFICANT CIVIL LIABILITIES FOR DAMAGES (INCLUDING WITHOUT LIMITATION STATUTORY DAMAGES) AND OTHER REMEDIES AND LIABILITIES, AND (3) MAY CONSTITUTE VIOLATION OF CRIMINAL LAWS.
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, YOU MAY, WITHIN THIRTY (30) DAYS OF PURCHASE AS EVIDENCED BY THE VENDOR'S RECEIPT AND/OR INVOICE, CONTACT THE VENDOR WHO SOLD YOU THE PRODUCT FOR
ANY REFUND OR CREDIT AS MAY BE ALLOWED BY THE VENDOR'S PRODUCT RETURN POLICIES. IF, HOWEVER, YOU PURCHASED
THE PRODUCT DIRECTLY FROM MINISOFT, YOU MAY RETURN THE PRODUCT, AND THE PURCHASE PRICE WILL BE REFUNDED IN
FULL ONLY IF CUSTOMER: (1) CONTACTS MINISOFT FOR A RETURN AUTHORIZATION NUMBER WITHIN THIRTY (30) DAYS FROM
DATE OF PURCHASE AS EVIDENCED BY THE PRODUCT RECEIPT/INVOICE; (2) RETURNS THE PRODUCT PACKAGE, INCLUDING
MEDIA, DOCUMENTATION, AND ALL RELATED ITEMS TO MINISOFT IN UNDAMAGED AND RESALABLE CONDITION; (3) CERTIFIES
IN WRITING THAT CUSTOMER HAS NOT INSTALLED, COPIED, DISPLAYED, EXHIBITED, PERFORMED OR OTHERWISE USED, KEPT,
DISTRIBUTED, SHARED, SOLD, LOANED ANY COPY OF THE SOFTWARE PRODUCT OR OTHERWISE VIOLATED THIS AGREEMENT
OR ANY OTHER RIGHTS OF MINISOFT; AND (4) FURTHER CERTIFIES IN WRITING THAT CUSTOMER'S SOLE REASON FOR REFUND IS
THAT CUSTOMER DOES NOT ACCEPT THIS AGREEMENT. IF CUSTOMER IS PURCHASING AN UPGRADE FOR AN EARLIER VERSION
OF THE PRODUCT, THEN THIS AGREEMENT SHALL SUPERSEDE THE TERMS AND CONDITIONS OF THE LICENSE AGREEMENT
THAT APPLIED TO THE EARLIER VERSION AS TO THE USE OF THE UPGRADE PRODUCT AS OF THE DATE OF INSTALLATION OF THE
UPGRADE.
NOW, THEREFORE, in consideration of the foregoing provisions and the terms and conditions herein contained and for other good and valuable consideration, the receipt and
sufficiency of which are hereby acknowledged, the following terms and conditions apply:
A. License Grants
1. Upon MINISOFT's receipt from Customer of the one-time license fee and further subject to the other terms and conditions herein, MINISOFT grants Customer a non-exclusive
and non-transferable perpetual license: (a) to install and use the Product on only one host computer or business server in Customer's business organization; and (b) to install the
client portion of the Product on a network server for access by more than one personal computer and on any personal computer client accessing the host server program.
2. You may not: (a) allow access to or use of the Product to anyone outside of your organization; (b) decompile, reverse engineer, decrypt, disassemble, or otherwise attempt to copy
or replicate the source code; (c) modify or translate those portions of the Product that are provided in an object or source code form, or alter, merge, modify, reverse engineer or adapt
the Product in any way including disassembling or decompiling; (d) copy, loan, rent, lease or sublicense, assign, convey, sell, mortgage, pledge, dispose or in any other manner
transfer to a third-party any part of or all of Customer's rights and obligations under this Agreement or in the Product; or (e) otherwise copy, distribute, rent, loan, disseminate,
publish, sell or transfer any portion of the Product in any way inconsistent with or contrary to the terms and conditions of the Agreement.
3. Any attempt to violate any prohibitions described in this Agreement shall be considered a material breach of this Agreement, and no attempt to violate section 2(c) or 2(d) in the
immediately preceding paragraph shall have any effect, and any prohibited act described therein shall be void and of effect if made by the Customer.
4. You may make one copy of the Product for use as a backup copy (the "Copy") provided that: (i) the Copy includes all notices of copyright and all other proprietary rights appearing
in and on the Software Product; (ii) the Copy and the original Product are not in use at the SAME time; (iii) Customer establishes a procedure for accounting for the Copy at all times;
and (iv) Customer destroys or returns to MINISOFT the Copy when it is no longer required or when the license grants made hereunder are terminated for any reason, whichever
occurs
first.
5. This Agreement grants to Customer a license for use of the Product on the terms and conditions set forth in this Agreement; and (ii) Customer may not install, copy, perform,
execute, display, or use in any other fashion the Product except in accordance with the terms and conditions of this Agreement. By any use of any element of the Product, Customer
shall be deemed to have accepted and be bound by all the terms and conditions of this Agreement.
6. MINISOFT retains and reserves all rights to the Product. Nothing contained herein shall be deemed to convey to Customer any title to, or an ownership interest in, the Product
or any of the intellectual property rights contained in the Product. Upon termination of this Agreement, all rights granted to Customer herein shall automatically revert to
MINISOFT.
B. Termination
The license grants made hereunder shall automatically terminate on the date of any breach by the Customer of any of the terms and conditions of this Agreement. In any such
termination, you shall discontinue using the Product. You further agree to return the Product to MINISOFT or destroy all components of the Product and to certify in writing that the
Product is no longer in use and that you have kept no copies of the Product. In any such termination of the license grants, none of MINISOFT's rights in law or equity shall be barred,
discharged, released, or otherwise impaired by such termination, and MINISOFT reserves all such rights. described herein.
C. Confidential Information
The Product also contains MINISOFT's commercially valuable, proprietary and confidential information and trade secrets (collectively "Confidential Information"). You are
obligated to preserve and hold in confidence any Confidential Information and may not use any of it except in accordance with the terms and conditions of this Agreement.
Confidential Information shall not include what is already public at the date of its disclosure or what later becomes lawfully public through no fault or responsibility of the Customer.
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D. Limited Warranties and Limitations on Damages and Remedies.
1. Only the limited warranties expressly described in this section are made to the Customer purchasing this Product. No warranty of any kind, whether express or implied, is made
to any third-party or other transferee or successor of the Customer.
2. MINISOFT warrants that it has the right to grant the licenses contained in this Agreement.
3. MINISOFT warrants that this product will execute its programming instructions when properly installed on a properly configured computer for which it is intended. MINISOFT
makes no warranty of any kind, implied or express, that the Product will meet Customer's requirements or that the Product will be uninterrupted or error-free. In the event that this
software product fails to execute its programming instructions, Customer's exclusive remedy shall be to return the media to MINISOFT to obtain replacement media. Should
MINISOFT be unable to replace the media, Customer shall be entitled to a refund of the purchase price upon the return of the Product and all copies.
4. MINISOFT, Inc. warrants the media upon which this Product is recorded to be free from defects in materials and workmanship under normal use for a period of 90 days from the
date of purchase. During the warranty period MINISOFT will replace media that prove to be defective. Customer's exclusive remedy for any media that proves to be defective shall
be to return the media to MINISOFT for replacement.
5. MINISOFT' only obligation, liability and/or remedy, with respect to the warranties set forth in this Agreement shall be one of the following, which MINISOFT shall have sole
discretion to choose: (1) as described above, to provide replacement media (whether in the form of the current release or otherwise) for the Product; (2) to replace, without charge,
the Product with a functionally equivalent software product; or (3) to refund the applicable license fees paid to MINISOFT by Customer. These are the sole and exclusive remedies
for any breach of warranty.
6. MINISOFT shall have no obligation, liability or any other kind of responsibility for the costs of restoring any destroyed or defective data, installation of replacement media, or
software conversion work made necessary by replacement media, even if MINISOFT had been specifically informed by Customer of the possibility or probability of any such
consequences. During the ninety (90) days warranty period for the media, MINISOFT will replace, without charge, on an exchange basis, any media which is not as warranted.
Customer must return the defective item postpaid to MINISOFT, postmarked within the time period stated above. Customer must either insure the defective item being returned or
assume the risk of loss or damage in transit. Any claim under the above warranty must include a copy of Customer's receipt or invoice or other proof of the date of delivery.
7. Year 2000 Warranty. MINISOFT warrants that the Product will accurately process date/time data (including, but not limited to, calculating, comparing, and sequencing) from,
into, and between the twentieth and twenty-first centuries, and the years 1999 and 2000 and leap year calculations, in accordance with the Product's documentation BUT ONLY to
the extent that other technology and systems (e.g., software and operating systems, hardware and firmware) used in combination with the Product properly exchanges date/time data
with it. In addition to the limitations of liability and remedies described above in this Section, the Year 2000 warranty made herein is made only for ninety (90) days after the date
of delivery of the Product and only if any noncompliance is discovered and made known to MINISOFT in writing within such ninety (90) days. The Year 2000 warranty expires after
such ninety (90) day period and shall not extend to any events occurring after the expiration date.
8. MINISOFT makes no other warranty, expressed or implied, with respect to the Product.

9. NOTICE: THE WARRANTIES, OBLIGATIONS AND LIABILITY OF MINISOFT AND THE RIGHTS AND REMEDIES OF CUSTOMER SPECIFICALLY SET FORTH IN THIS AGREEMENT ARE THE CUSTOMER'S EXCLUSIVE REMEDIES. MINISOFT DISCLAIMS, AND CUSTOMER HEREBY WAIVES, DISCHARGES AND RELEASES MINISOFT, ITS OFFICERS, DIRECTORS, EMPLOYEES AND AGENTS, FROM
ANY AND ALL (1) OTHER WARRANTIES, OBLIGATIONS, OR LIABILITIES AND (2) RIGHTS, CLAIMS, CAUSES OF ACTIONS, EXPRESS
OR IMPLIED, ARISING BY LAW OR OTHERWISE IN CONNECTION WITH, REGARDING, OR ARISING FROM THE PRODUCT OR ANY
RELATED SOFTWARE, TANGIBLE OR INTANGIBLE ITEMS OR SERVICES PROVIDED UNDER THE AGREEMENT (INCLUDING, WITHOUT LIMITATION, ALL DOCUMENTATION SUPPLIED WITH THE PRODUCT). THE WAIVER, DISCHARGE AND RELEASE INCLUDE,
BUT ARE NOT LIMITED TO: (1) ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A SPECIFIC PURPOSE; (2) ANY
IMPLIED WARRANTY ARISING FROM COURSE OF PERFORMANCE, COURSE OF DEALING, OR USAGE OF TRADE; AND (3) ANY OBLIGATION, LIABILITY, RIGHT, CLAIM, OR REMEDY, WHETHER IN TORT, CONTRACT, OR OTHERWISE. IN NO CASE SHALL MINISOFT
BE LIABLE FOR ANY INCIDENTAL, INDIRECT, SPECIAL, CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, LOSS OF
USE, REVENUE, PROFIT, OR DATA), PUNITIVE DAMAGES, EXEMPLARY OR OTHER STATUTORY DAMAGES, EXPENSES, COSTS (INCLUDING ATTORNEY FEES). IN ADDITION, IN NO CASE SHALL MINISOFT'S LIABILITY EXCEED THE FEES PAID BY CUSTOMER FOR
THE PRODUCT.
E. Updates
MINISOFT at its sole discretion may release one or more free updates, patches, or fixes for the Product. The Product license fee covers any free updates, patches and/or fixes to the
Product. You must notify MINISOFT of changes in e-mail address, mailing address, and contact name, in order to ensure you receive notification of any such free release. Nothing
in the foregoing, however, requires MINISOFT to release any free updates, patches or fixes for the Product.
F. Miscellaneous
1. Governing Law. This Agreement is made for the sole benefit of the parties hereto, and there are no third party beneficiaries to this Agreement. This Agreement shall be interpreted
under the laws of the State of Washington, notwithstanding the application of any jurisdiction's choice-of-law rules to the contrary.
2. Independent Contractors. No agency, partnership, joint venture, or employer-employee relationship is created hereby, and neither party nor any of its agents or employees shall
have any authority of any kind to bind the other party in any respect whatsoever. Each party is an independent contractor to the other party.
3. No Assignment by Customer. This Agreement shall be binding upon and inure to the benefit of MINISOFT and any successors and assigns. Customer shall have no right to assign
or otherwise transfer its rights or obligations under this Agreement except with the prior written consent of MINISOFT, which MINISOFT in its sole discretion and for any reason
or no reason provide or withhold.
4. Entire Agreement. This Agreement contains the complete understanding between the parties and shall as of the date the Product is first installed supersede all other agreements,
whether they are written or oral, between the parties concerning the particular subject matter. The language of this Agreement shall for all purposes be construed as a whole,
according to its fair meaning, not strictly for or against either party, and without regard to the identity or status of any person who drafted all or any part of it. No purchase order or
any other purchasing instruments issued by Customer, even if such purchase order or other purchasing instrument provides that it takes precedence over any other agreement between
the parties, shall be effective to contradict, modify, delete from or add to the terms of this agreement in any manner whatsoever.
5. Severability. In the event that any one or more provisions of this Agreement is found by a court of competent jurisdiction to be unenforceable or invalid, then notwithstanding any
such finding the remainder of this Agreement shall remain in full force and effect, and such provision that is found to be unenforceable or invalid shall be deemed severed.
6. Waiver. Neither party's right to require performance of the other party's obligations hereunder shall be affected by any previous waiver, forbearance, or course of dealing, nor shall
any waiver or forbearance or other course of dealing at any time with respect to any term or condition in this Agreement be effective unless evidenced in writing signed by the waiving
party as to such waiver, forbearance or other course of dealing. No waiver or modification of this Agreement or any covenant, condition or limitation herein contained shall be valid
and no evidence of waiver or modification shall be offered or received in evidence in any proceeding, arbitration or litigation between the parties hereto arising out of or affecting this
Agreement or the rights or obligations of the parties hereunder, unless such waiver or modification is in writing duly signed by both parties.
7. Headings, Sections - The various headings in this Agreement are inserted for convenience only and shall not affect the meaning or interpretation of this Agreement or any Section
or provision hereof.
8. Disputes; jurisdiction and venue. Customer and MINISOFT consent to personal jurisdiction, subject matter jurisdiction, and venue in the state and/or federal courts sitting in King
or Snohomish Counties, State of Washington. Any action relating to this Agreement must be brought in the state or federal courts located in King or Snohomish County, Washington.
9. Attorney's Fees. In the event legal action is brought by either party to enforce any of the provisions of this Agreement, the prevailing party shall recover its reasonable attorney's
fees, costs, and expenses, including but not limited to fees, costs and expenses of collecting any judgment.
10. Export. The export of this product is restricted by U.S. export regulations.
11. GOVERNMENT RESTRICTED RIGHTS. The Software Product and documentation are provided with restricted rights. Use, duplication or disclosure by the Government is
subject to restrictions as set forth in subparagraph (c)(2)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252. 227-7013 or subparagraphs (c)(1) and (2)
of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Contractor/manufacturer is MINISOFT, INC., 1024 FIRST STREET, SNOHOMISH,
WASHINGTON, 98290, U.S.A.
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Chapter 1

Introduction

Chapter 1: Introduction

What is MS92 for MAC
MS92 for Macintosh provides HP700/92, VT100, and HP ANSI terminal
emulation for Macintosh users. MS92 allows your Macintosh to access
data, applications, and storage capacity of your Hewlett-Packard or other
host computers, just as if you were using the emulated terminal.
You can connect MS92 to your host by direct cable, modem, or local area
network (LAN). With MS92, you have options no ordinary terminal can
provide. You can log host data to printers or disk files and automate any
task using the TermTalk scripting language. MS92 takes full advantage
of the advanced capabilities of the Macintosh interface, including multitasking, on-line help, and cut and paste with the clipboard. You can also
transfer any type of file between your Mac and host computer.
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MS92 for MAC Specifications
Ter
minal Em
ulatio
n
erminal
Emulatio
ulation
To the standard terminal capabilities required by host applications, MS92
adds the power, productivity, and convenience of the Macintosh environment.

HP Terminal Display Features
♦

User selectable number of columns (40-200)

♦

Configurable scrolling memory

♦

Line or smooth vertical scrolling

♦

Row and column counters

♦

Underline or block cursor

♦

Configurable HP display enhancements (inverse, underline, halfbright, blinking, security)

♦

Text and background colors (HP2397 color pairs) can be specified
via a dialog box or an escape sequence.

HP Keyboard Functionality
♦

Scrolling and cursor positioning via keyboard or mouse

♦

Edit keys

♦

Terminal control keys

♦

Function keys F1 - F12

♦

Numeric keypad and arrow keys

♦

Configurable RETURN, TAB, ENTER, and BACKSPACE keys

♦

Supports 7-bit operation with Danish, French, German, Norwegian,
Spanish, Swedish/Finnish, and United Kingdom character sets

♦

Supports 8-bit operation with Apple international keyboards automatically translating characters into HP Roman-8.
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HP Terminal Modes and Functions
♦

Block/line, block/page, and character mode

♦

Format or unformatted mode

♦

Remote or local mode

♦

Display functions

♦

Memory lock

♦

Auto line feed

♦

Insert character

♦

Keyboard lock

♦

Local echo

♦

Configurable terminal ID

♦

Transmit-only fields

♦

Recognizes all HP escape sequences.

HP Function Key Emulation
♦

Function keys F1 - F12

♦

Loadable values and two-line on-screen labels

♦

Function keys can be entered by clicking label, pressing F1 - F12 on
keyboard or selecting menu command

♦

HP System keys supported via menu items and dialog boxes.

VT100 and HP ANSI Emulation
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♦

Function keys PF1- PF4

♦

On screen LEDs emulate indicators on DEC keyboard

♦

Answerback message

♦

Configurable BACKSPACE and shifted BACKSPACE

♦

HP ANSI emulation adds support for HP escape sequences and
downloadable function keys F1 - F12.
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Powerful Logging
♦

Log to local printer, clipboard, or disk file

♦

Log lines off top or off bottom of display memory

♦

Log current line, page, all of display memory, display memory from
cursor, or selected text via menu items

♦

Output logged to printer is spooled on disk until you print.

Macintosh Convenience and Ease of Use
♦

Use mouse or keyboard to position cursor, scroll, select commands,
and enter function keys

♦

Pause button suspends scrolling of received data

♦

On-screen control bar lets you toggle between editing keys, tab/
margin ruler, and control character entry

♦

Control bar can be hidden for added screen space

♦

On-screen indicators show row/column position of cursor, status of
host connection, keyboard lock, logging, and script recording/
execution

♦

User selectable screen font size

♦

All terminal, keyboard, connection, and other settings can be saved
to a settings file on disk.
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Co
nnectivit
Connectivit
nnectivityy
MS92 for Macintosh supports a variety of standards-based networking
options for the Mac user, including serial, modem, and local area network (LAN) hardware connections such as NSVT and Telnet. Using
MS92, you can log on to an HP3000, HP9000, HP1000, DEC VAX,
UNIX-based system or other host computer.

Supported Connections
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♦

Serial using printer or modem port (300 to 57,600 baud)

♦

Automatic dialup with Hayes-compatible modems
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F ile Tr ansf
er
ansfer
MS92 provides reliable, high performance file transfer to a variety of
hosts. Companion programs for HP3000 and HP 9000 systems interact
with MS92’s file transfer facility to ensure error-free transmission. File
transfers run in background mode so you can work on other tasks while
the transfer is in progress.

HP3000 and HP9000 transfers include
♦

Data compression

♦

Dynamically sized data blocks based on network characteristics

♦

Support for 7-bit and control character sensitive networks

♦

Backup of Macintosh files to host

♦

Archival of host files to Mac (Mac can act as intermediary in HP-toHP file transfer)

♦

Conversion between HP and Mac text formats

♦

Translation between HP Roman-8 and ANSI international characters.

Transfers with other hosts
♦

Includes XMODEM protocol for binary transfer to HP1000 and
other non-HP hosts
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Scr
ipting L
anguage
Scripting
Language
MS92 includes TermTalk, a scripting language that automates repetitive
tasks. TermTalk is a modern, block-structured language that provides
control of MS92’s communication with the host and interface to the user.
For best performance, MS92 automatically compiles TermTalk scripts
into object code the first time they are executed.

Scripts can be used to
♦

Set configuration values, dial modems, and log on users

♦

Run host or Macintosh applications and print files

♦

Transmit and log data

♦

Create and delete files on Macintosh or host

♦

Send and receive files to and from other computers

♦

Display dialog boxes and accept user input

♦

Modify the position, size, and appearance of MS92 windows.

Scripts can be created with
♦

Any Macintosh or host-based text editor

♦

MS92’s script recorder, which observes user actions and generates
TermTalk commands to reproduce those actions.

Session 4.3:
MS92’s script editing window, which features:
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♦

Cut, Copy, Paste, and Find functions

♦

Command syntax checking

♦

Paste Command function enters default command syntax without
typing

♦

Access to all Macintosh fonts, sizes, and styles
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Scripts can be
♦

Distributed (in source code or object code) to users

♦

Added to and executed from the Script menu

♦

Assigned to function keys F1 - F12

♦

Run directly from the built-in editor window

♦

Run automatically when a MS92 is started or ended

♦

Initiated by other scripts

♦

Initiated by the host via an escape sequence

♦

Initiated by another Macintosh application using AppleEvents.
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Sample Scripts
Inside your MS92 folder is a folder titled Scripts. This folder contains
sample TermTalk scripts that demonstrate some of the ways you can
configure and use MS92, as well as some of the things scripts can do. To
find out more about using these scripts, open the Read Me file in that
folder.
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Requirements and Installation
To use MS92, you must have at least:
♦

10 MB of memory on your Macintosh

♦

Running 10.2 or later

Installing MS92 for MAC
MS92 is shipped on a CD. To install MS92 follow these steps:
1. Insert the MS92 CD into your CD ROM drive.
2. Once the MS92 CD icon appears on your desktop, double click the
icon.
3. From the list of files in the MS92 CD folder double click the MS92
Installer icon.
4. The Install MS92 program will automatically start:

2-2
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The specific files installed include: INSTALL.TTS, MS92 Fonts, 1.
TYMLINK3000, TYMLINK9000/300, TYMLINK9000/800,
UPLOAD.C.
5. Follow the installer prompts. You may be asked to Restart your
Macintosh.
6. MS92 is now ready to use.
The installation procedures for Tymlink (the file transfer companion
program for HP hosts) are described in Chapter 9. Note: Your System
Manager or Mac/PC coordinator may have already done this.
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Running MS92
Start MS92 in any of the following ways:
♦

Double-click the application icon.

♦

Double-click a settings file you have created or that was given to you
by someone else.

♦

Use any other standard method for running a Macintosh application:
select the icon, then choose Open from the Finder’s File menu
choose an alias you have created.

The start up MS92 screen appears:

2-4
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Log on
To log on, do the following:
1. HP700/92 emulation is the default. If you wish to emulate something other than an HP700/92 terminal, choose Terminal from the
Settings menu:

2. Enter the desired HP terminal ID or choose HP ANSI or VT100
from the Emulation pop-up menu, then click OK.
Note: If you are using a LAN or modem connection to the host,
choose Connection from the Settings menu to configure the connection type and options such as host node name or phone number:
Additional configuration settings are made using the
SESSION.HOSTS file, as documented in Chapter 8.
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4. Press Return. Like all other characters you enter from the keyboard
when the MS92 window is active, the Return character is transmitted to your host system. If you are configured properly, the host
returns a prompt character (usually colon (:) on the HP3000 and
dollar sign ($) on the HP9000).
5. If no prompt is displayed, check your hardware connections. Then
check your configuration values by choosing Connection and
Terminal from the Settings menu. These dialog boxes replace the
System keys on an HP terminal. If you have questions about the
appropriate configuration for communications with your host, see
your system manager.

2-6
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Creating a Settings File
If you make changes to the default configuration, choose Save from the
File menu to save your changes in a settings file.

You can give this file a name that corresponds to the connection type
and/or host it is used with, such as HP9000 or Modem to CompuServe.
Next time you need to log on with this configuration, run MS92 by
double-clicking the appropriate settings file, not the MS92 program icon.
When you choose Save or Save As, the status of the following items are
recorded in a settings file:
♦

All settings made from the Settings menu—terminal, connection,
color, file transfer, logging, keyboard/character set, function keys,
display enhancements, and script

♦

Tab and margin settings made from the control bar

♦

Status of the control bar: hidden or displayed, and whether edit
buttons, control character buttons, or margin/tab ruler are displayed

♦

Status and contents of function key labels

♦

Size and position of MS92 and script windows

If you are already using a settings file, choosing Save updates the file
with any changes made since the last save. If you are not working with
an existing settings file, a dialog box is displayed for you to enter a file
name. If you are already using a settings file, and want to save the
changes you have made under a different name, choose Save As.
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To create a settings file that opens automatically when you double-click
the MS92 icon, save your file with the name MS92 Defaults in the same
folder as MS92.
As you become familiar with MS92’s capabilities, you may want to
create startup and shutdown scripts and link them to your settings files. A
startup script is performed automatically when a settings file is opened; a
shutdown script is executed when it is closed. For example, you could
create a startup script that sends your log on to the host and runs your
host application. A shutdown script could exit the application and log off.
A sample startup script can be found in Chapter 7 under the heading
Write a startup script.
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File Menu
The File menu contains commands that manage settings files, control
connection and printing, and initiate file transfer.

Open
Loads a settings file created with Save or Save As.

S ave / SSaave A
Ass
Records the current status of the following items to a settings file on
disk:
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♦

All settings made using commands from the Settings and Utility
menus

♦

Tab and margin settings

♦

Status of the control bar

♦

Status and contents of function key labels

♦

Size and position of MS92 window.
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If you are already using a settings file choosing Save updates the file
with any changes made since the last save. If you choose Save As,
the current settings are saved under the name you specify. If you
save a file that has not been saved before, the Save As dialog box is
always displayed.
You can load the configuration specified in a settings file by doubleclicking the file or by choosing Open from MS92’s File menu.

Re
ver t to SSaaved
Rev
Returns all settings to the values last saved in the current settings
file, or to MS92’s defaults if no settings file is in use.

Send F
ile
File
Transfers a file to a host using the protocol and other settings
indicated in the File Transfer Settings dialog box. Other options are
selected in the dialog boxes shown on the next page.
HP3000 or HP9000 Transfers
If the selected protocol is either MS92 to HP3000 or MS92 to
HP9000, one of the following dialog boxes is displayed.
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Options:
File Types
In the upper right corner of the box, a checkmark indicates what
type of Macintosh file is being transferred. This cannot be changed.
Macintosh File Types
File Type
Text File
H P 3000 or
H P 9000 F i l e

3-4

Description
A Macintosh file containing only text characters and tabs;
special formatting information such as fonts, page breaks,
etc., is not included.
A backup copy of a host file, transferred to the
Macintosh with MS92's Backup HP3000 file or Backup
HP9000 file option.

P ai nt F i l e

A file of the PNTG file type.

Other

Any other type of file.
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HP3000 File Characteristics
The default file name is created from the first letter and up to seven
subsequent letters and digits of the Macintosh file name. If you do
not qualify the file name with a group and account, it is copied into
your log on group. You can override all or part of the default name
by entering a fully qualified HP3000 file name, including a lock
word if desired.
The default Record Size is shown in another box. You can supply a
different record length only when converting to an EDITOR file or
performing a binary transfer. If length is expressed in bytes, the
maximum is 32,766. If length is expressed in words, the maximum
is 16,383.
Also indicated is whether the data is ASCII or Binary.
HP9000 File Name
The default file name is created using the first 14 letters and digits
of the Macintosh file name. If you do not qualify the file name with
a path name, the file is copied into your working directory. You can
override all or part of the default file name by entering a new file
name or path name.
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Conversion Options
Depending on the host you are transferring to and the type of
Macintosh file, one or more of the conversion methods listed below
is available.
File
Type

Option

Description

Conv ert t o
EDITOR
f ormat ,
word wrap

To perform word wrap, each record of the EDITOR
file is filled with as many whole words (text separated
by spaces or non- printing characters) from the
Macintosh file as fit in the established record length.

Text

A single carriage return is replaced by a space. When
consecutive carriage returns are encountered, each
one after the first causes a blank record to be written
to the EDITOR file. Other non- printing characters are
replaced with a space. To change the way tab
characters are handled, click the Options button
Conv ert t o
EDITOR
f ormat ,
ret ain lines

Each paragraph in the Macintosh file (string of data
terminated by a carriage return) is written to a single
record in the HP3000 file. If a line is too long to fit in
the established record length, as many characters as
fit are placed in the record and additional records are
written.

Text

A single carriage return is replaced by a space. When
consecutive carriage returns are encountered, each
one after the first causes a blank record to be written
to the EDITOR file. All other non- printing characters
are replaced by a space. To change the way tab
characters handled, click the Options button
Tex t ;
change
<CR> t o
< LF >
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Converts a Macintiosh text file into a file suitable for
Text
use with HP- UX editors such as vi. It converts a text
file that uses the carriage return character to separate
lines or paragraphs into a file that uses the linefeed or
newline character for this purpose. It is comparable to
the icrnl option in the stty command and in the termio
structure used by the ioctl system call.

Minisoft 92 for the MAC

Chapter 3: Menu Reference

File
Type

Option

Description

Binary
Transf er

Copies all data in the Macintosh file into binary file All types
on the host with no modification. Only the data
fork of the file is copied; the resource fork, filetype,
and icon are not. When performing a binary
transfer, each record in the host file is completely
filled with data.

Back up
Macint osh
f ile

Copies any Macintosh file to the host so that it can
later be restored with the Restore Macintosh file
option in the Receive File dialog box.

All types

Rest ore
HP3000
or
HP9000
f ile

This option restores a file previously archived on
the Macintosh with the Backup HP3000 file or
Backup HP9000 file option in the ReceivedFile
dialog box.

HP3000
or
HP9000

Options Button
The Options button is available for transfers of Text Files to the
HP3000 only. It allows you to convert tabs in the Macintosh file to a
specified number of spaces in the host file.
XMODEM Transfer
When MS92 to XMODEM protocol is selected in the File Transfer
Settings box and you choose Send File from the File menu, transfer
begins as soon as you select the file to send. The XMODEM program on the host should already be running.
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Recei
ve F
ile
Receiv
File
Receives a file from the host using the protocol and other settings
indicated in the File Transfer Settings dialog box.
HP3000 or HP9000 Transfers
If the protocol selected is either MS92 to HP3000 or MS92 to
HP9000, you are first prompted to type in the name of the host file
to receive. Once that file has been located on the host, one of the
following dialog boxes is displayed:
HP3000

HP9000

3-8
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File Types
In the upper right corner of the box, a checkmark indicates what
type of file is being transferred. This cannot be changed.
File Type

De s cription

Text File

On the HP3000, this is an ASCII sequential file with record
length less than 256 bytes. The file must have either no file
code or the file code EDTCT (designating a COBOL source
file). On the HP9000, this is a file with no magic number or
system ID number in its first four bytes.

Macintosh
File

A backup copy of a Macintosh file, previously transferred to
the host with MS92's Backup Macintosh file option.

Other

Any host file that is not a text file. KSAM and IMAGE files
cannot be transferred.

Macintosh File Name
The default file name and location of the file created on the
Macintosh can be overridden with new values.
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Conversion Options
Depending on the host you are transferring from and the type of
Macintosh file, one or more of the conversion methods listed below
are available.
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File Type

Option

Description

Conv ert t o
t ex t f ormat
word wrap

To perform word wrap, each record of the
Text
EDITOR file is filled with as many whole words
(text separated by spaces or non- printing
characters) from the Macintosh file as fit in the
established record length. Single carriage returns
are replaced by a space. When consecutive
carriage returns are encountered, each one after
the first causes a blank record to be written to
the Mac file. Other non- printing characters are
replaced with a space.

Conv ert t o
t ex t f ormat ,
ret ain lines

All trailing blanks are stripped from each record
in the EDITOR file and a single carriage return
is appended. Non- printing characters are
placed by a space.

Text

Tex t ; change
< LF > t o
<CR>

Converts each newline or linefeed character in
the HP- UX text file into a carriage return. It is
comparable to the onlret option in the st t y
command and in the t ermio structure used by
the ioct l system call.

All types

Binary
t ransf er

Copies all data characters in the HP file into a
Macintosh file with no modification.

All types

Back up
HP3000 or
HP9000 f ile

Copies any HP file to the Macintosh so that it
later can be restored with the Restore HP3000
file or Restore HP9000 file option in the Send
File dialog box

All types

Rest ore
Macint osh
f ile

This option restores a Macintosh file previously
archived on the HP with the Backup Macintosh
file option in the Received File dialog box.

Macintosh
file
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XMODEM Transfer
When MS92 to XMODEM protocol is selected in the File Transfer
Settings box and you choose Receive File from the File menu,
transfer begins as soon as you select the file to receive. The
XMODEM program on the host should already be running.

Connect
If you have chosen Modem as your connection type in the Connection Settings dialog box (choose Connection from the Settings
menu), this command dials the phone number entered there.
When you have chosen NSVT or Telnet as your connection type in
the Connection Settings dialog box, choosing Connect initiates the
handshaking necessary to connect you to the specified host.
If you have chosen Serial as your connection type, connection to the
host is established automatically. This command is disabled.

Disconnect
If you are using a modem, choosing this command terminates the
telephone connection. Disconnect only works with a Hayes-compatible modem. See Chapter 8 under the heading Modem connection for
further details.
If you are using a LAN, choosing this command terminates the LAN
connection.
If you are using a serial connection, this command is disabled.
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Pag
up
agee Set
Setup
Displays the standard page setup dialog box. Controls the format of
printing initiated with Print File or Print Logged.

P r int F
ile
File
Displays a dialog box in which you can select any TEXT type file to
be printed.

P r int Scr
een Copy
Screen
Makes a screen print of your current window and prints the screen
print to the configured printer.

Q uit
Terminates execution of MS92. Though Quit does not terminate
your MS92 on the host computer, it does shut down any LAN
connection you may have to the host.
3-12
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Edit Menu
The Edit menu controls cut and paste with the Macintosh clipboard, HPstyle screen control, and editing.

Undo
Not used in MS92. Available for use with desk accessories.

Cut
Cuts selected data to the clipboard, removing the data from display
memory.

Copy
Copies selected data to the clipboard, leaving the data in display
memory. If you select a line of data terminated by a carriage return,
the carriage return is also copied.
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Past
astee
Pastes data from the clipboard to the current cursor position, leaving
the data on the clipboard. Carriage returns are pasted along with
text.

Clear
Clears selected data from display memory without placing it in the
clipboard.

Copy Tab
le
able
Copies selected data to the clipboard, converting one or more spaces
in the copied text into one tab character.

Copy W indow Imag
Imagee
Places an image of the current contents of the window, including
function keys, on the clipboard in PICT format. By default, the
window image is copied as a single bitmap. Hold down the SHIFT
key, and then select this item to copy the image as multiple objects.
This facilitates editing of text.

Clear Display
Emulates the CLEAR DISPLAY key on an HP terminal, clearing
from the current cursor position to the end of display memory.

Clear Line
Emulates the CLEAR LINE key on an HP terminal, clearing from
the current cursor position to the end of the line.
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De
let
Delet
letee Line
Emulates the DELETE LINE key on an HP terminal, removing the
entire line in which the cursor is located. Subsequent lines are
scrolled up one line to take the place of the deleted line; the cursor is
moved to the left margin.

Inse
Inserrt Line
Emulates the INSERT LINE key on an HP terminal, inserting a
blank line preceding the one in which the cursor is located. The line
in which the cursor is located and all subsequent lines are moved
down one line; the cursor is moved to the left margin of the newly
inserted line.

De
let
Delet
letee Char
Charaa ct
cteer
Emulates the DELETE CHAR key on an HP terminal, removing the
character at the current cursor position. Characters to the right of the
deleted character are moved left one position.

Inse
Inserrt Char
Charaa ct
cteer
Emulates the INSERT CHAR key on an HP terminal, enabling you
to insert multiple characters into a line without overwriting existing
characters. Existing characters are shifted right one position for each
character you insert; characters shifted past the right margin are lost.
When Insert Character is chosen, insert character mode is turned on,
and the Ins Char edit button on the control bar is inverted. To turn
this mode off, choose the command again.
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Clear A
ll Tabs
All
Clears all tab settings.

Clear A
ll Margins
All
Clears margin settings, returning to the default left margin at column
one and default right margin at column 80, 132, or 160, depending
on the Number of Columns you have chosen in the Display area of
the Terminal Settings box.
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Settings Menu
The Settings menu contains items that control all configurable aspects of
MS92’s operation. All Settings menu options are saved when you select
Save or Save As from the File menu to create a settings file. When such a
file is opened, all the options it contains are enabled.

Te r minal
This dialog box contains items that control terminal emulation and
screen display:
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Title
Text you enter here is displayed in MS92’s title bar, replacing MS92
from Tymlabs.
Emulation
There are three choices in this pop-up menu. The choice you make
effects both the Terminal ID/Answerback area immediately beneath
it, as well as the options displayed when you click the Options
button at the lower right of the box.
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♦

HP
Emulates an HP700/92 terminal, and responds to status requests
from programs running on the host (escape sequence ec *s^)
with the configured Terminal ID. The default is 70092. If you
want the host program to handle communications with MS92 as
if it were talking to an HP2392 terminal, enter 2392A in this
area. Other possible entries include 2622A or 2624A.

♦

HP ANSI
Emulates HP ANSI terminal support (VT100 plus a limited
group of HP escape sequences). Responds to enquiries (ENQ)
from the host with the configured Answerback. The answerback
may include control characters.

♦

VT100
Emulates a DEC VT100 terminal. Responds to enquiries (ENQ)
from the host with the configured Answerback. The answerback
may include control characters.
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Display
The following items control the terminal display.
♦

Number of Screens
For HP terminals, the default is 10, and the upper limit is determined by available memory. For HP ANSI terminals, the default
is 1, and the upper limit is determined by available memory. For
VT100 terminals, a grayed-out 1 is displayed, as no more than
one screen of memory can be configured.

♦

Lines per Screen
Default is 24.

♦

Number of Columns
On each of the terminals emulated, you can choose from 40-200
column operation from this menu.
Default: 80

♦

Font Size
MS92 uses custom fonts in order to display text in the 24-row by
80-column format of a terminal screen. The fonts include the
standard alphanumeric characters and symbols plus the characters used to display control characters. Line drawing and other
alternate character sets are provided as well. Alternate character
sets are activated using escape sequences.
You can choose to display text in either 10-point or 12-point
characters. When you change the size, the font used in the
function key labels and control bar is also resized.
Default: 12 point

Cursor Type
The cursor can be an Underscore or a Block Cursor.
Default: Underscore Cursor
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Max to 24 x 80
Normally, when you click the zoom box at the right of the title bar,
the area of the MS92 window zooms between the size you last chose
by dragging the grow box and the size of your monitor. When this
box is checked, the window zooms between the size you last chose
by dragging the grow box and the program default, which is 24 rows
x 80 columns.
Default: Max to 24 x 80 off
Show Control Bar
When this box is checked, the control bar and rotator button at the
top of the screen are displayed. When it is not checked, the control
bar is hidden and this area is used to display data.
Default: Show control bar on
Show Indicators
When this box is checked, the row and column counters, connection
indicator, keyboard lock indicator, logging indicator, and script
indicator at the lower left of the window are displayed. When it is
not checked, the indicators are hidden.
Default: Show indicators on
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Options
MS92’s terminal options are described below. Each terminal emulated supports a subset of these, listed in its Options dialog box.
HP:

HP ANSI:
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VT100:

Straps:
Transmit Functions (A)
When Transmit Functions is turned off, the functions of special keys
for cursor movement, the arrow keys, and so on, are performed
locally. They are not transmitted to the host computer. When Transmit Functions is turned on, the escape sequences are transmitted to
the host computer and performed at the terminal, only if they are
echoed by the host. (If Local Echo is also turned on, the sequences
are performed locally and sent to the host, so if the host echoes them
back they are performed twice.)
Default: Transmit Functions off
Inhibit Line Wrap (C)
When Inhibit Line Wrap is turned off, MS92 wraps automatically to
the next line when the cursor reaches the right margin. This causes
the cursor to move to the left margin of the next line. When Inhibit
Line Wrap is turned on, the cursor remains at the right margin until a
carriage return or some other cursor movement function is performed. Any characters entered overwrite the existing character in
the last column of the current line.
Default: Inhibit Line Wrap off
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Page Mode (D)
There are two types of block mode operation: block/page mode
(Page Mode on) and block/line mode (Page Mode off). In block/
page mode, all data in display memory (or only the unprotected
fields if format mode is enabled) is transmitted when you press
ENTER. In block/line mode, data is transmitted one line at a time
(or one unprotected field at a time if format mode is enabled).
Default: Page Mode off
Inhibit Handshake (G)
Together with Inhibit DC2 (strap H), the setting of this field determines the type of handshaking used when transferring data from the
terminal to the host computer.
Default: Inhibit Handshake off
Inhibit DC2 (H)
Together with Inhibit Handshake, the setting of this field determines
the type of handshaking used when transferring data from the
terminal to the host computer.
Default: Inhibit DC2 off
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Modes:
Local Echo
When operating in remote mode with Local Echo turned off, characters are transmitted as you key them. If the remote system echoes the
characters, they are displayed on your screen. When you operate
with Local Echo turned on, MS92 displays the characters in addition
to transmitting them. If the host echoes them back, they are displayed twice. However, if the host is operating in half duplex mode
it does not echo the characters, so Local Echo must be turned on to
display the characters on the screen. For example, this may be the
case when running over an X.25 network.
When you are operating in local mode, MS92 displays the characters you enter automatically. The Local Echo setting has no effect.
Default: Local Echo off
Block Mode
Indicates whether the terminal is operating in block mode or character mode. When operating in character mode, characters are transmitted to the host as they are keyed. In block mode, data is transmitted when you press the ENTER key on the numeric keypad on your
Macintosh.
There are two types of block mode operation: block/page mode
(Page Mode on) and block/line mode (Page Mode off). In block/page
mode, all data in display memory is transmitted when you press
ENTER. In block/line mode, data is transmitted one line at a time.
Default: Block Mode off, character mode operation
Remote Mode
When Remote Mode is ON a communications link exists between
the terminal and the host computer. When Remote Mode is OFF no
such link exists; the terminal is operating in local mode.
Default: Remote Mode on
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Smooth Scrolling
When Smooth Scrolling is enabled, data is rolled up and down the
screen smoothly, rather than jumping a line at a time. As on an HP
terminal, Smooth Scrolling is rather slow.
Default: Smooth Scrolling off
Memory Lock
Locks all lines on the screen above the current position of the cursor.
The locked lines remain frozen in position while lines preceding and
following scroll beneath them. Memory Lock also has a second
function. If the cursor is homed before memory lock is turned on, all
lines in display memory are protected so that no data can be lost off
the top.
Default: Memory Lock off
Display Functions
When Display Functions is turned on, a special character set is used
to display ASCII control codes and escape sequences instead of
performing the functions as usual.
Default: Display Functions off
Auto Line Feed
When Auto Line Feed is on, an ASCII line feed control code is
automatically appended to each ASCII carriage return control code
generated through the keyboard.
Default: Auto Line Feed off
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Format Mode
When Format Mode is on, data can be typed only in unprotected
fields, and only unprotected fields are transmitted to the host
computer when you press ENTER. When Format Mode is off, data
can be typed anywhere on the screen and all data is transmitted.
Default: Format Mode off
Inhibit Line Wrap (C)
When Inhibit Line Wrap is turned off, MS92 wraps automatically to
the next line when the cursor reaches the right margin. This causes
the cursor to move to the left margin of the next line. When Inhibit
Line Wrap is turned on, the cursor remains at the right margin until a
carriage return or some other cursor movement function is performed. Any characters entered overwrite the existing character in
the last column of the current line.
Default: Inhibit Line Wrap off
Miscellaneous Options:
Auto Horizontal Scroll
When Auto Horizontal Scroll is on, scrolling occurs automatically
when character data reaches the right edge of the screen. By default,
this mode is off so that data can be placed in display memory
beyond the right edge of the screen without scrolling, thereby
increasing display speed.
Default: Auto Horizontal Scroll off
Auto Keyboard Lock
Most HP3000 applications that perform block transfers lock and
unlock the keyboard so that no characters can be typed while the
transfer is in progress. However, when running over X.25 networks,
such locking is usually not performed. When Auto Keyboard Lock is
enabled, MS92 automatically locks the keyboard and the mouse at
the beginning of a block transfer and unlocks them when the transfer
is complete.
Default: Auto Keyboard Lock off
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Disable Bell
Disables the ringing of the terminal bell by applications running on
the host. Also disabled is the automatic ringing performed by MS92
when the cursor reaches the position eight characters to the left of
the right margin and when an unprotected field is completely filled
in format mode.
Default: Disable Bell off
Multi-Line Paste Waits For Prompt
or Multi-Line Paste Waits for Host Prompt
To allow you to paste multiple lines of data into your host applications, MS92 waits at the end of each line for the host computer to
return a designated character to signal that it is ready to receive
another line of data. On the HP3000, this Host Ready character is a
DC1 (ASCII value 17). For compatibility with other hosts and
applications, you can configure whether MS92 waits for a host
ready character, and what this character is.
Default: Multi-line Paste Waits on; Host Ready char is DC1
Disable Host Control
Unless this option is selected, MS92 allows a host computer to
execute almost any TermTalk script language command using the
host control facility. The host sends the text of the command to
MS92 in an escape sequence. MS92 then compiles and executes the
command. Depending on the escape sequence used to send the
command, MS92 returns a completion status code to the host so the
host program can tell if the command was successfully executed.
See Appendix D of the TermTalk manual for details. When this
option is selected, MS92 ignores host control escape sequences.
Default: Host Control enabled
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Delay after ESC
When you are operating above 2400 baud with Transmit Functions
turned on, the use of the mouse for cursor positioning can cause data
overruns on the HP3000. The overruns are due to the rate at which
this process generates escape sequences. If this occurs, use this
option to specify a delay after the transmission of each escape
character. The delay is specified in sixtieths of a second.
Default: No delay after ESC

Connection
The Connection pop-up menu lets you choose from Serial, Modem,
AdvanceNet, or Telnet connection. (For more details on direct,
modem, and LAN connection see Chapter 10.) The connection
options in the lower portion of the box change as you make different
choices from the pop-up menu.
Serial:
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Modem:

NSVT:
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Telnet:

Port
The port used to connect your Macintosh to the host.
Default: Modem
Baud
The speed of data transmission in bits per second.
Default: 9600
Parity
The type of parity generation and checking used with each data
character transmitted and received. This is followed by a slash and a
numeral indicating the number of bits per character. MS92 sets stop
bits to one or none automatically, depending on your parity selection.
Default: None/8
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ENQ / ACK Protocol
Enables the use of the Hewlett-Packard ENQ/ACK handshake. On
the HP3000 under MPE (though not under MPE XL), you must be
signed on to a port configured as TERMTYPE 10 (or add the
TERM=10 parameter to your :HELLO command) to use ENQ/ACK.
Default: ENQ/ACK Protocol on
XON / XOFF Input Control
Enables the use of XON (DC1) and XOFF (DC3) handshake with
transmissions to the terminal.
Default: XON/XOFF Protocol on
XON / XOFF Output Control
Enables the use of XON (DC1) and XOFF (DC3) handshake with
transmissions from the terminal. This may be required when running
over an X.25 network if the local pad is configured to use XON/
XOFF flow control.
Default: XON/XOFF Protocol off
Phone Number
For modem connections, enter the phone number, including pause
characters (,) if necessary.
Hayes-Compatible Modem
If your modem is Hayes-compatible, click the appropriate radio
button. Indicate whether the phone line is tone or pulse, and if you
like choose Redial Until Connected. The setup and dialing commands for Hayes-compatible modems are performed automatically.
See Modem connection in Chapter 8.
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Other Modem Type
If you are using a modem that is not Hayes-compatible, choose
Other Modem. Include any setup and dialing commands required in
the phone number string. (Strings that contain multiple carriage
returns cannot be entered in this box, and must be typed from the
keyboard. You could also write a TermTalk script to dial the number.) Pause characters (,) may also be entered in the phone number if
necessary.
Redial Until Connected
Default unchecked.
Hardware (DTR) Hangup
Useful primarily when you are not actually communicating using a
modem, but are hard-wired to a host network. Choosing Hardware
(DTR) Hangup changes what happens when you choose the Disconnect command from the File menu, or when an ec -f (modem
disconnect) is received. Instead of sending the usual hang up commands, the DTR (Data Terminal Ready) line on the serial port is
lowered for two seconds.
Host Node Name
Specifies the node name of the target computer for LAN connections. For more information on configuring a LAN connections, see
LAN connection in Chapter 10.
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Color
If you have a color monitor, text displayed by MS92 can be colored
the same way it is on an HP2397 terminal, using color pairs. A color
pair is composed of a foreground color used for the characters, and a
background color used for the area around the characters. MS92
adds the capability to change the colors used for each pair to any of
the colors available on the Macintosh using the dialog box below.

The color pair assignments shown above are terminal defaults. Host
applications can make other assignments. HPDESK, for example,
displays function keys with color pair 3. The color pairs not labeled
above are often used by VPlus block mode applications.
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When you click any foreground or background color, a color wheel
is displayed:

Move your pointer around the wheel until you see the desired new
color in the top half of the Select a new color box. When you click
OK, the color in this box replaces the color you clicked.
For information on setting color with escape sequences, see Appendix A.
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Function Ke
ys
Keys
Like those of an HP terminal, MS92’s function keys F1 through F12
can be redefined either locally or by a program executing on the host
computer.
When the Function Key Settings dialog box first appears, the
definitions for F1 through F8 are displayed. To display the definitions for F9 through F12, click the F9 - F12 button. To return to the
defaults for all keys, click Defaults.
To turn on display functions so that control characters in your
message strings are displayed, check the box at the bottom of the
screen.
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For each key, the following four fields may be set:
Function
When you choose String, the function key works as on an HP
terminal. The string you specify is either transmitted to the host or
performed locally, depending on the setting of the Attribute field.
When you choose Script, the function key runs the script whose
name is shown in the String or Script field.
Label
Two lines of eight characters each, displayed in the on-screen
function key labels.
String or Script
For a String type function key, this is the string transmitted to the
host or performed locally. For a Script type function key, this is the
name of the script. You can either type in the name of a script file or
click the Script button at the bottom of the box to choose a script.
The path name can be up to 80 characters in length.
Attribute
String type function keys are assigned an operational attribute:
Normal, Transmit, and Local. Transmit, the default, sends the value
and adds a carriage return to the end of it. Normal sends the value
with no carriage return. Local displays the value on your screen
without transmitting anything. The Attribute field has no meaning
for Script type function keys.

Display Enhancements
HP terminals provide four different display enhancements (blink,
inverse, underline, and half-bright) that may be used individually or
in combination to highlight fields on the screen. The Macintosh
supports all of these enhancements accept half-bright, and MS92
adds box and bold enhancements.
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You control how the display enhancements requested by your
application are implemented by MS92 using the dialog box below.

For each of the possible HP enhancement combinations, you can
specify any combination of box, bold, blink, underline, and inverse.
By default, the bold enhancement is substituted whenever halfbright is requested. The box enhancement is not used by default, but
can be substituted for any of the other enhancements. It is helpful
with applications that use multiple enhancements to display bar
charts, such as HP OPT/3000.
If you are running in color, the half-bright and inverse display
enhancements are implemented as they are on an HP terminal. Color
pair 3 (cyan on white) is used for half-bright, and inverse is implemented by reversing the foreground and background colors of the
current color pair.
Note that use of the box and inverse enhancements slows MS92’s
display speed.
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Once you have clicked OK in this box, MS92 must go through all of
display memory checking (and possibly changing) the existing
enhancements. This process may take several seconds, depending on
the number of screens in memory.

Ke
yboar
d / Char
Keyboar
yboard
Charaact
cteer Set
You can configure character set and keyboard options in the box below.

Character Set
Language
MS92 supports both 7-bit and 8-bit operation, meaning it can send,
receive, and represent ASCII characters using either 7 or 8 bits. Its
default is 8-bit ASCII. In 8-bit ASCII mode, you enter international
characters in standard Macintosh style. (To locate characters not
labeled on your keyboard, use the Key Caps desk accessory, and
select the HPScreen font from the Key Caps menu. On the U.S.
keyboard, many characters are generated using the ALT/OPTION
key.)
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MS92 translates the characters you type into the corresponding HP
Roman 8 characters before transmitting them to the host. Conversely, characters sent from the HP host computer are translated
into the Macintosh character set as they are received.
A chart of the Roman 8 international characters is found in Appendix B.
If you choose a 7-bit language in the Keyboard/Character Set dialog
box, only a subset of international characters is supported. You can
enter these characters in Macintosh style, described above, or HP 7bit style. To enter an international character in HP 7-bit style, see
Appendix B.
Default: 8-bit ASCII
Alternate Set
Here you choose which alternate character set is enabled by the
Shift-In control characters.
Default: Line Drawing
Keyboard Options
You can configure the BACKSPACE, SHIFT BACKSPACE,
ENTER, TAB, CLEAR, and RETURN keys. By default, the function of each of these keys corresponds to the key with the same
name on an HP terminal keyboard. The exception is the Shift
Backspace combination that produces a regular backspace on an HP
terminal but produces a destructive backspace in MS92.
Backspace Key, Shift-Backspace combination
The BACKSPACE key and SHIFT BACKSPACE combination can
each be configured to produce a nondestructive backspace, a destructive backspace, or a DEL character. The DEL character, decimal value 127 of the ASCII character set, is also produced by
pressing CTRL + BACKSPACE.
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Enter Key
The ENTER key on the numeric keypad can be configured to
generate Enter or Return. The Return setting is useful when typing
numbers from the numeric keypad.
Tab Key
The TAB key can be configured to generate either a tab character,
the number of spaces needed to reach the next tab stop, or a carriage
return. If Spaces is selected, backtab characters are converted into
the number of backspaces needed to reach the previous tab stop.
Clear Key
The CLEAR key can be configured to generate either Clear Display
or Escape. The Escape setting is useful if your keyboard does not
have an ec key.
Return Key
Most HP software differentiates between the Return key and the
Enter key, as HP terminals provide keys for each of these functions.
When operating in block mode on an HP terminal, pressing Enter
sends a block of data to the host. The Return key is used to send a
line of data while operating in character mode.
Normally, the ENTER key on the Macintosh numeric keypad is used
as the Enter key. If you like, you can configure the RETURN key as
Enter.
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F ile Transfe
ansferr
File transfer method and defaults are configured in the dialog box
shown below.

Transfer Method
The transfer method chosen determines the protocol used when you
initiate file transfer by choosing Send File or Receive File from the
File menu.
Startup Sequence
If you have installed the Tymlink program in some group other than
PUB.SYS on an HP3000 or in some directory other than /usr/bin on
the HP9000, you must edit the command used to initiate execution.
On the HP3000, you can also precede the RUN command with a
colon or some other character to allow file transfers from within a
host application that supports the entry of MPE commands in this
way.

Minisoft 92 for the MAC

3-41

Chapter 3: Menu Reference

Transfer Non-Text Files As
A Macintosh file that is not a text file can be transferred to the host
in two ways. One is Binary, which sends the data in the file but not
any of its file attributes. The other choice is Macintosh Backup,
which transfers both the data and the file attributes so that the file
can be restored onto a Macintosh. The choice you make here determines which of these choices is the default in the Send File dialog
box.
Network Sensitive Options
♦

Use substitutes for 8-bit characters
Choose this option only if you use data communications equipment that is not transparent to 8-bit bytes (only supports the
transmission of 7-bit data). This option is also required for file
transfer using a Telnet connection.
When this option is chosen, MS92 recodes any character with a
decimal value greater than 127 into two 7-bit bytes during
transmission and decodes it to its original 8-bit form before
writing it to the destination file. This slows transfer proportionately to the number of characters recoded and should be used
only when necessary.
Some X.25 and other switching networks are sensitive to 8-bit
characters and require that this option be selected.

♦

Use Substitutes for Control Characters
Choose this option if you are sending files using data communications equipment that is not transparent to ASCII control
characters (attempts to act on, rather than transmit, the control
sequence).
When this option is chosen, control characters embedded in the
transmitted file are recoded during transmission and decoded to
their original form before being written to the destination file.
This option slows transfer proportionately to the number of
characters recoded and should be used only when necessary.
All X.25 networks, PADs, and switching networks are sensitive
to control characters, and require that this option be selected.
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♦

Host Provides DC1 Pacing
When Host provides DC1 pacing is chosen (default status),
MS92 uses DC1s as the pacing character for data transmissions
to the HP3000. If the option is not chosen, MS92 introduces time
delays for pacing with the host, rather than the DC1 character.
Using time delays slows transfer proportionately to the speed at
which your host system can accept characters.
Deselect this option if you are performing a file transfer over an
X.25 network, if you are logged on as TERMTYPE 18 or 24, or
any time you are not logged on as TERMTYPE 10 or are not
using a port configured as TERMTYPE 10. If your file transfers
have problems starting up, or if no data is sent, try deselecting
this option. It may be that you are not logged on as TERMTYPE
10.

Log
ging
Logging
This dialog box is used to configure logging direction.

Logging Direction
Log Lines Off Top
Lines are logged as they scroll off the top of display memory.
Log Lines Off Bottom
Lines are logged as they are displayed.
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Scr
ipt
Script
Use this dialog box to select scripts you want executed automatically, as
well as scripts to be added to the Script menu.

Do when opening a settings file
The script whose name is indicated here is executed automatically
when the settings file is opened. When the cursor is in this box, you
can use the Select button to open a file dialog from which you can
choose a script file, or you can type in a name manually.
Do when closing a settings file
The script whose name is indicated here is executed automatically
when the settings file is closed. When the cursor is in this box, you
can use the Select button to open a file dialog from which you can
choose a script file, or you can type in a name manually.
Show on Script Menu
The scripts whose names are shown in this area are listed on the
Script menu. Click Add to open a file dialog and choose Scripts to
add to the list. To remove a script, highlight its name and click
Remove. After you click OK, these scripts are listed on the Script
menu.
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Utility Menu
The Utility menu provides fast access to frequently used keys and
modes.

Br
eak
Break
Emulates the function of the BREAK key on an HP terminal,
dropping the Transmit Line state for 200 milliseconds. Clicking the
Break button on the control bar can also perform break.

Soft Reset
Emulates the function of the RESET key on an HP terminal. MS92’s
soft reset does the following:
♦

display Functions and Keyboard Lock are turned off

♦

any data communication transfers in progress are canceled

♦

the bell rings

♦

and the screen are refreshed.
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Har
d Reset
ard
Emulates the CTRL + SHIFT + RESET key combination on an HP
terminal. MS92’s hard reset does the following:
♦

Display memory is cleared.

♦

All tabs are cleared. (Margins are not cleared.)

♦

The following configuration values and mode settings are reset
to their default values:
-Page mode off
-Inhibit Line Wrap (strap C) off
-Inhibit Handshake (strap G) off
-Inhibit DC2 (strap H) off
-Transmit Functions off
-Keyboard Lock off
-Memory Lock off
-Insert Character mode off
-Display Functions off
-Any datacomm transfers in progress are canceled and the
buffers are emptied
-Display Functions and Keyboard Lock are turned off
-If enabled, record mode and logging are disabled
-The bell rings
-The screen is refreshed.

Block Mode
When Block Mode is checked, data is transmitted when you press
the Enter key. When you are operating in character mode (no
checkmark beside this item), characters are transmitted to the host as
they are keyed.
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Remot
Remotee Mode
When Remote Mode is checked, a communications link exists
between the terminal and the host computer. In local mode (no
checkmark beside this item), no transmissions are sent or received.

For
mat Mode
ormat
When Format Mode is checked, data can be typed only in unprotected fields, and only unprotected fields are transmitted to the host
when you press Enter. When format mode is off (no checkmark),
data can be typed anywhere on the screen and all data is transmitted.

Display F
unctions
Functions
When Display Functions is checked, control characters entered are
not acted upon but are displayed using a special character set.

A uto Line F
eed
Feed
When Auto Line Feed is checked, an ASCII line feed control code is
automatically appended to each ASCII carriage return control code
generated through the keyboard.
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Ke
yboar
d Lock
Keyboar
yboard
When Keyboard Lock is checked, all keys except command key,
SHIFT, and CTRL are disabled. On-screen edit buttons, except for
Reset and Break, are locked as well. The mouse can only be used to
choose menu commands.
When the keyboard is unlocked, any keystrokes during the locked
period are flushed.

Memor
Memoryy Lock
When Memory Lock is checked, all lines on the screen above the
current position of the cursor are locked. The locked lines remain
frozen in position while lines preceding and following the locked
lines scroll beneath them. Memory Lock also has a second function.
If the cursor is homed before memory lock is turned on, all lines in
display memory are protected so that no data can be lost off the top.
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Keys Menu
Commands that control the function keys are found on the Keys menu.

Hide / Show Ke
ys
Keys
Hides the on-screen function keys. When the keys are hidden, this
command changes to Show Keys. When the keys are shown, you
can select a key by clicking it with the mouse.

Lock Ke
ys
Keys
Locks the function keys into their current state (hidden or displayed). If the keys are visible when Lock Keys is selected, they
cannot be hidden with the Hide Keys command or by an escape
sequence. If they are hidden, they are prevented from being displayed.
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Ke
abels
Keyy L
Labels
The labels currently defined for each function key are displayed in
the lower portion of the menu. You can enter a function key by
choosing it here.
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Log Menu
Commands that control logging are found on the Log menu. The first six
commands on the menu (Start Logging, Log Line, Log Selected Text,
Log Page from Cursor, Log All from Cursor, and Log All) log data to a
temporary file. You can print the logged data, save it in a file, place it on
the clipboard or discard it using the last four commands on the menu
(Print Logged, Save Logged to File, Save Logged to Clipboard, and
Clear Log.)

The Hewlett-Packard concept of a destination device is not used in
MS92. You always log the data to a temporary file, and then send it
where you want it to go.
Log Line, Log Selected Text, Log Page from Cursor, Log All from
Cursor, and Log All are executed slightly differently when chosen from
the menu and when performed using an escape sequence. When performed using an escape sequence, MS92 sends the terminating character
S or F (the host program requesting the copy should be waiting for this
status indicator). When chosen from the menu, the terminating character
is not sent.
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St
ar
ging / Stop Log
ging
Star
artt Log
Logging
Logging
Used to enable or disable logging off top or off bottom, as indicated
using the Logging command from the Settings menu. When Start
Logging is chosen, this command becomes Stop Logging.

Log Line
Logs the entire line in which the cursor is currently located. After
the line is copied, the cursor is moved to column one of the next
lower line.

Log Se
lect
ed Text
Select
lected
Logs the currently selected text. This command is grayed out unless
some text is selected on the screen. The cursor is not moved after the
text is copied.

Log P
ag
om Cursor
Pag
agee fr
from
Logs all lines on the screen, starting from the line the cursor is
currently on and ending after the last visible line on the screen. After
the page is copied, the cursor is moved to column one of the line
after the last visible line on the screen.

Log A
ll fr
om Cursor
All
from
Logs all lines in display memory, starting from the line the cursor is
currently on and ending after the last visible line on the screen. After
the page is copied, the cursor is moved to column one of the line
after the last visible line on the screen.
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Log A
ll
All
Logs all lines in display memory. After the lines are copied, the
cursor is moved to column one of the line following the last line in
display memory.

Inse
ag
eak
Inserrt P
Pag
agee Br
Break
Places a page break (or a form feed) in the log file.

P r int Log
Loggged
Sends logged output to configured printer, and clears the current log.
See also Page Setup on the File menu and Logging on Settings
menu.

S ave Log
ile
Loggged to F
File
Saves logged output to a text type file. When you choose this
command, a dialog box is displayed in which you can enter a name
for the file.

S ave Log
d
Loggged to Clipboar
Clipboard
Saves logged output to the clipboard. Logged data can then be
pasted back into MS92 or into another application.

Clear Log
Clears the contents of the current log.
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Script Menu
The commands on the Script menu are used to create and run scripts
written in TermTalk, MS92’s script language. For more information on
TermTalk, see the TermTalk manual.

Do Scr
ipt / Stop Scr
ipt
Script
Script
Executes the script you select in the File Open dialog box displayed.
After this command has been chosen, it changes to Stop Script,
which terminates script execution.

Pause Scr
ipt / Resume Scr
ipt
Script
Script
Suspends execution of a script. When this command is chosen, it
changes to Resume Script, which restarts script execution.
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Do Command
Displays a dialog box in which you can choose a single TermTalk
command, edit the default syntax, and click OK to execute it. You
can also type a command in the edit box.

Recor
d a Scr
ipt / Stop Recor
ding
Record
Script
Recording
When you choose this command, MS92 “watches” you perform
subsequent operations, automatically recording the TermTalk
commands needed to perform those operations. When this command
is chosen, it changes to Stop Recording. When you choose Stop
Recording, a box is displayed in which you can name and save the
script just created.

Pause Recor
ding / Resume Recor
ding
Recording
Recording
Suspends automatic command recording initiated with Record a
Script so that you can pick up where you left off after switching to
another application or performing some other task you don’t want
recorded. After this command has been chosen, it changes to Resume Recording, which restarts the recorder.
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Show Scr
ipt W indow
Script
Displays a window in which you can write, record, and edit scripts.
The menus and features of the script window are documented in the
TermTalk manual.
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The following information describes how to change the way MS92 looks
on your screen, from resizing the window to changing the color of the
function keys. To save any changes you make in a settings file choose
Save or Save As from the File menu. Open that file to run MS92 with
your settings in effect.
MS92 adds several elements to the standard MAC window:

From top to bottom, the MS92 window special features are:

4-2

♦

Control bar edit buttons, from Break to Home Up in the above
example.

♦

Control bar rotator, immediately to the right of the Home Up button.
When you click the rotator once, the control bar changes to a margin/
tab ruler:
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Click it again for control character buttons:
♦

Pause button—the little ⌧ symbol immediately beneath the control
bar rotator—suspends and resumes scrolling.

♦

Function keys, F1-F8, are shown toward the bottom of the screen.

The bottom of the screen displays, from left to right:
♦

Row and column counters.

♦

Connection indicator:
indicates you are connected and/or operating in remote mode.
indicates you are not connected and/or operating in local mode.

♦

Keyboard lock indicator:
indicates the keyboard is locked.
indicates the keyboard is unlocked.

♦

Logging indicator:
indicates no logging is in progress.
indicates logging is in progress.

♦

Script status indicator:
indicates no script activity.
indicates script compiling.
indicates a script is running.
indicates a script is being recorded.
indicates the script is paused.
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When VT100 or HP ANSI emulation is selected in the Terminal Settings
dialog box, the following changes are made:

Note that the control bar now shows the PF1-PF4 VT100 function keys,
and the bottom row has additional indicators that emulate keyboard
LEDs.

4-4

Minisoft 92 for the MAC

Chapter 4: Configuring the Display

Sizing the Window
To change the size of the MS92 window, use any of the following
methods:
♦

Place your pointer over the grow box at the lower right. You can drag
from the minimum window size (4 rows x 35 columns) to the full
size of your monitor.

♦

Click the zoom box in the upper right corner to enlarge the window
to maximum size. Click again and it shrinks to the size it was before
you enlarged it.

♦

Configure MS92 so that clicking the zoom box resizes the window to
24 x 80 rather than the full size of the monitor, choose Terminal from
the Settings menu, and select the Zoom to 24 x 80 option.

Note: Changing the width of the window does not cause MS92 to display
data to the right of column 80 unless you configure 132 or 160 column
operation. See Change the Number of Columns and Lines immediately
below.
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Changing the Number of Columns
and Lines
MS92 can display 40-200 columns whether all columns are used depends
on your host application.
Like a terminal, MS92 keeps track of data displayed on the screen so you
can review or log it after it has scrolled out of view. By default, 10
screens (240 lines) of data are maintained in memory when in HP
terminal emulation mode. When in HP terminal emulation mode, you can
configure as many additional screens as the memory in your Macintosh
will support.
To change the number of columns or screens in memory, select Terminal
from the Settings menu.
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Changing the Title
It may be useful to have the title bar of the MS92 window display text
that describes the purpose of the current settings file. For example, the
title could describe the host system for which the settings file is configured (HP9000 - Headquarters) or the application it logs on to (Customer
Database). To change the title displayed in the title bar, note the following:
♦

Start MS92 by double-clicking the application icon or the MS92
Defaults file, the title bar reads Minisoft MS92.

♦

Double-click on a settings file; the name of the file is then displayed
in the title bar.

♦

Specify a title in the Terminal Settings box, this title is displayed
instead of the name of the program or settings file.

Hiding Function Keys and Control Bar
If you have a small monitor and would like to display additional lines of
data, use the following techniques:
♦

Choose Hide Keys from the Keys menu. The function keys are erased
and the additional two lines are used for data. You can still select
Function Keys from the Keys menu or from the keyboard.

♦

Choose Terminal from the Settings menu and uncheck Show control
bar by clicking on it. The control bar is erased and the additional line
is used to display data.
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Changing Font Size
MS92’s terminal display uses a built-in font called HPScreen. This font
is designed to provide a 24 x 80 display that accurately emulates the
terminal and includes all the HP alternate character sets.
To select either 12 or 10-point type, choose Terminal from the Settings
menu and choose a size from the Font Size pop-up menu.

Changing Cursor Shape
You can use either the default underline cursor or a block cursor. To
change the cursor type, select Terminal from the Settings menu and click
either the Underscore or Block Cursor.
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Using Color
Text displayed by MS92 can be colored the same way it is on an HP2397
terminal, using color pairs. A color pair is composed of a foreground
color, used for the characters, and a background color, used for the area
around the characters. MS92 lets you change the colors of each pair to
any of the colors available on the Macintosh.
To change the colors of any color pair, do the following:
1. Select Color from the Setting menu:

2. Determine which color pair you want to modify and click either the
foreground or background color.
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3. A color wheel is then displayed:

4. Move your pointer around the wheel until you see the desired color
in the New color box. When complete select OK, the new color will
then display in the color pair dialog box.
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Reconfigure Display Enhancements
HP terminals provide four display enhancements that applications can
use to highlight data on the screen. These are:
♦

Blinking

♦

Inverse (On a monochrome terminal, white text is displayed on
black. On a color terminal, the foreground and background colors of
color pair 0 are reversed.)

♦

Underline

♦

Half-bright (On a monochrome terminal, text is dimmed. On a color
terminal, it is displayed using color pair 3.)

MS92 supports all of these accept half-bright on a monochrome monitor,
and adds box and bold enhancements. MS92 substitutes bold whenever
half-bright is requested on a monochrome monitor.
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To substitute any enhancement for another, do the following:
1. Choose Display Enhancements from the Settings menu.
2. Each row in the box below shows you what combination of enhancements is used when each of the various enhancements or
combinations is requested. Reconfigure these relationships by
checking and unchecking boxes.
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Terminal Keyboard Functions
The charts below show how special keys on a terminal keyboard are
emulated by MS92.

Terminal Control Functions
H P K ey

M S92 Equivalent

Ent er

ret urn

Ct rl

cont rol
Command k ey opt ion (For Mac Plus and 512KE.)

Esc
F 1 - F 12

Enter control characters using the control bar. Click the rotator at
the right of the bar to display control characters buttons.
esc
Click the ESC button on the control bar.
F1 - F12
Choose from the Keys menu

Break

For F1 - F8 only, click on- screen label or type command k ey 1
through command k ey 8.
Click Break on the control bar.
Choose Break from the Utility menu.

Reset

Type command k ey B.
Click Reset on the control bar.
Choose Soft Reset from the Utility menu.

Shif t - Ct rl Reset

Type command k ey hyphen.
Hold alt /opt ion while you click the Reset button on the control
bar.
Choose Hard Reset from the Utility menu.
Type command k ey R.
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Editing Functions
H P key

M S92 equivalent

Clear Line

shif t - clear
Click Clr Line on the Control bar.
Choose Clear Line from the Edit menu.
Type command k ey L.

Clear
Display

clear
Click Clr Disp on the control bar.
Choose Clear Display from the Edit menu.
Type command k ey J.

Delet e Char

del
Click Del Char on the control bar.
Choose Delete Character from the Edit menu.
Type command k ey E.

Delet e Line

Click Del Line on the control bar.
Choose Delete Line from the Edit menu.
Type command k ey D.

Insert Char

shif t - ins/help
Click Ins Char on the control bar.
Choose Insert Character from the Edit menu.

Insert Line

Click Ins Line on the control bar.
Choose Insert Line from the Edit menu.
Type command k ey I.
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Cursor Movement and Scrolling Functions
H P key

M S92 equivalent

Home Up

hom e
Click Home Up on the control bar.

Home Down

end
Hold the alt /opt ion key while you click the Home Up button on
the control bar.

Home Up,
Clear
Display

alt /opt ion - shif t - clear
Hold alt /opt ion and shif t while you click the Home Up button
on the control bar.

Arrow k eys

Use arrow keys or mouse to move cursor.

Roll Up

Use shif t plus arror keys (not available on Mac Plus).
Click Scroll arrows.

Roll Down

Use shif t plus arrow keys (not available on Mac Plus).
Click scroll arrows.

Prev

page up
Click scroll bar.

Nex t

page down
Click scroll bar.
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Reconfiguring Special Keys
To reconfigure the use of Return, Enter, Tab, Clear, and Backspace
(labeled Delete on the Macintosh keyboard), do the following.
1. Choose Keyboard/Character Set from the Settings menu:
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2. Reconfigure the keys as desired. The most common uses of the
options available are:
♦

The Backspace key setting is important for VT100 emulation, to
mimic the use of the Backspace key on VT100 terminals.

♦

Use the Tab key Spaces setting for fast cursor positioning in
applications where the Tab key can’t normally be used. It
converts a tab into the number of spaces needed to reach the next
tab stop.

♦

Clear key to Escape if your keyboard has no ESC key.

♦

Return key to Enter for convenience in block mode.

♦

Enter key to Return for convenience when typing numbers from
the numeric keypad.

These settings are saved in your settings file when you choose Save or
Save As from the File menu.
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Using a Language Other Than English
MS92 supports both 7-bit and 8-bit operation, meaning it can send,
receive, and represent ASCII characters using either 7 or 8 bits. Its
default is 8-bit ASCII. If you don’t use international characters such as •,
¿, and £, this should be fine. To use a language other than U.S. English:
1. Choose Keyboard/Character Set from the Settings menu (see the
illustration in the previous section).
2. Select the desired language in the dialog box.

In 8-bit ASCII mode, enter international characters in standard
Macintosh style. (To locate characters not labeled on your keyboard, use
the Key Caps desk accessory and select the HPScreen font from the Key
Caps menu. On the U.S. keyboard, many characters are generated with
the ALT/OPTION key.) MS92 translates characters typed into HP
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Roman-8 characters before transmitting them to the host. Conversely,
characters received from the host are translated into the Macintosh
character set. A chart of the Roman-8 international characters is found in
Appendix B.
If you choose a 7-bit language, you can enter international characters in
Macintosh style, described above, or HP 7-bit style. To enter an international character in HP 7-bit style, press the USASCII key with the same
decimal value. A chart showing these correspondences is found in
Appendix B.
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Setting Special Function Key Values
By defining and saving your own function key values, you can enter
frequently used commands or run TermTalk scripts with a single keystroke or mouse click. To define and save function key values, follow the
steps below.
1. Select Function Keys from the Settings menu:

2. For each function key you want to set up, choose String or Script
from the Function pop-up menu.
Choosing String displays text on the screen or transmits it to the
host. Choosing Script runs a TermTalk script.
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3. Use the mouse to position the cursor to the Label field. The text you
type here appears in the on-screen button and on the Keys menu.
You may enter two lines of up to eight characters each.

Before typing a new value, highlight the current label and delete it.
To wrap down to the second line, fill the first line completely with
characters or spaces.
Note: Pressing the Return key is the equivalent to clicking OK—it
closes the dialog box.
4. Press tab or use the mouse to select the String or Script field.
For a String type key, type the string you want to send to the host or
display on your screen. To enter control characters in your string,
check the Display Functions box. This way when you enter control
key sequences, they are included in the function key value rather
than acted on as usual.
For a Script type key, click the Script button at the bottom of the box
to select a script.
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5. For String type keys only, make a selection from the Attribute popup menu.
♦

Send the string to the host and add a carriage return, choose
Transmit.

♦

Send the string to the host without appending a carriage return,
choose Normal.

♦

Display the string in the MS92 window without sending it,
choose Local.

6. Click OK to close the dialog box and put the changes you have made
into effect, or
Click Cancel to close the box, discarding changes, or
Click Defaults to return all values to program defaults, or
Click F9-F12 to define these additional keys:

All the buttons in this box apply only to F9 - F12. After you click
OK or Cancel, MS92 returns you to the F1 - F8 box.
7. Save your function key settings in a settings file by choosing Save or
Save As from the File menu. When you start MS92 by opening this
file, the function keys are loaded automatically.
Tip: Your function key definitions are removed when a host application loads its own function key values and labels. Since most applications use only F1 - F8, you can avoid having some definitions
wiped out by putting them in F9 - F12. Also, you can reload function
keys saved in your settings file by choosing Revert from the File
menu. This won’t interrupt your host MS92.
Minisoft 92 for the MAC
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Finally, you could write a TermTalk script, which loads function key
definitions; assign it to one of the keys between F9 and F12 so that it
doesn’t get wiped out, and run that script whenever you need to
reload the function keys.
The following shows sample function key definitions:
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The labels are displayed at the bottom of the MS92 window and on the
Keys menu:

You can execute any function key by pressing F1 through F12 on the
keyboard or selecting it from the menu. F1 through F8 can also be
selected by clicking the labels or by entering a command key 1 through a
command key 8.
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Logging
One way of saving, printing, or copying MS92 data is to log it to a
temporary file called a log file. You can then send the log file to the
printer, save it as a permanent file on your Mac or copy it to the clipboard.
The various methods of logging are described below.

Log Data in Display Memory
If the data you want to log has already appeared on the screen, and is
now located somewhere in display memory, you can log it using any one
of the following methods:
♦

Highlight the data to be logged by dragging the pointer over it.
Choose Log Selected Text from the Log menu to place it in the log
file.

♦

Place the cursor on the first line you want to log, and choose one of
the following:
Log Line - Logs the line the cursor is on.
Log Page from Cursor - Logs from the line the cursor is on to the
last line in the window.
Log All From Cursor - Logs from the line the cursor is on to the last
line in display memory.

♦
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Choose Log All to log all lines in display memory.
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Log Data Interactively
If you want to log data as it is displayed, do the following:
1. When logging is turned on, MS92’s default is to copy lines to the
log file as they appear on the screen. This is called logging lines off
bottom. To log lines as they scroll out of display memory, choose
Logging from the Settings menu and click Log Lines Off Top.

2. Choose Start Logging from the Log menu.
3. List the data or enter the commands you want to log on the screen.
4. When all lines have been logged, choose Stop Logging from the Log
menu.
Tip: In block mode, you may find that some full screen applications
do not log their screens properly. This is because the application
directly positions the cursor to each field without sending line feeds
on every line.
To log a full-screen application, select the desired text and use the
Log menu command Log Selected Text, or position the cursor to the
top of the area you wish to log and use Log Page from Cursor.
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Append to an Existing Log File
You can use any of the methods described above to add more data to the
end of an existing log file. Choose Insert Page Break from the Log menu
between instances of logging. When you print the log file, a new page
begins every time a page break is encountered.

Print Logged Data
To send the current contents of the log file to the printer, choose Print
Logged from the Log menu. After printing, the log file is cleared.
To print logged data in the same font as it appears on the screen, you
must install the fonts in the suitcase called MS92 Fonts into the System
file in your System folder. The font suitcase is found in the MS92 folder.

Save Logged Data
To save the data in the log file to a permanent file on your Macintosh,
choose Save Logged to File from the Log menu. A dialog box appears in
which you name the file. After saving, the log file is cleared.
The ability to save logged data to a file provides a quick way to transfer
files or portions of files from host systems or on-line services. Just list
the data you want transferred on the screen, log it, and save it to a file.
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Put Logged Data on the Clipboard
To place the contents of the current log file on the clipboard so it can be
pasted into another Macintosh application or back into MS92, choose
Save Logged to Clipboard from the Log menu.

Erasing the Log File
To remove all data in the log file without printing, saving, or copying,
choose Clear Log from the Log menu.
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Using Cut, Copy, and Paste
As in any Macintosh application, you can select data in the MS92
window and Copy or Cut it to the clipboard. You can then Paste the data
back into the MS92 window or into any other Macintosh document.

Redo Commands and Automate Data Entry
To redo a single MPE or host application command, do the following:
1. Select the desired line by dragging over it with the mouse. Do not
select the prompt at the beginning of the line, but do drag to the end
of the line so the invisible carriage return that follows the other
characters is selected.
If you want to edit the line before copying it, put the terminal in
local mode by unchecking the Remote Mode item on the Utility
menu. After you make the changes, go back into remote mode and
select the line as described above.
2. Choose Copy (command key C) or Cut (command key X) from the
Edit menu.
3. At the host or application prompt, choose Paste (command key V)
from the Edit menu. The pasted line is displayed on the screen and
transmitted to the host.
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You can also paste multiple lines of data into MS92, automating the
entry of a series of commands typed into a text file, or adding lines
copied from a Macintosh text file one by one into an HP text file. Because MS92 waits for a Host Ready prompt before sending each additional line, data is handled just as if it were being typed from the keyboard. When preparing for a multi-line paste, be aware of the following:
♦

There should be no prompts or other characters normally supplied by
the host in the text you paste.

♦

By default the Host Ready prompt MS92 expects is DC1, which is
appropriate for the HP3000 but may not be for other hosts. To
reconfigure this, choose Terminal from the Settings menu and click
the Options button in that dialog box. Choose a different control
character from the Multiline Paste Waits for Host Prompt scroll box.
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Copy Columnar Data into a Spreadsheet
If you plan to paste data that appears on your screen in columns into a
spreadsheet or word processor, you can convert the spaces that separate
each column into tabs. This allows you to paste it directly into the cells
of a spreadsheet, or into a word processor where you’ve set tabs for each
column. Do the following:
1. Drag with the pointer to select the desired lines.
2. Choose Copy Table from the Edit menu.
3. Paste the data into your other Macintosh application.
Note that every occurrence of one or more spaces is converted to a tab,
including the spaces between the words of any headings or other text.

Document Application Screens
You can take a screen shot of the contents of the MS92 window and
place it on the clipboard in PICT format. Function keys and any colors
on the screen are included in the picture and a black outline is drawn
around the window. You can then paste this image into any Macintosh
program that supports PICT files. To do this, choose Copy Window
Image from the Edit menu. Note the following:
♦

By default, the image is copied as a single bitmap.

♦

To copy the window as multiple objects rather than a single bitmap,
hold down the shift key while you select Copy Window Image. The
window outline, each line of text, the function key outlines, and
labels are copied as separate objects so each can be edited individually in a drawing program.

To give your other Macintosh program access to the fonts used by MS92,
copy the fonts in the suitcase called MS92 Fonts into the System file in
your System folder. The font suitcase is found in the MS92 folder.
If you don’t copy the HPScreen font, screen data appears in the default
font of your graphics application.
6-8
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Tymlink Companion Program
The Tymlink program is shipped with MS92 to provide intelligent file
transfer between the Macintosh and an HP3000 or HP9000. For other
transfers, MS92 supports XMODEM protocol.
Three versions of Tymlink are provided: Tymlink 3000, Tymlink 9000/
300, and Tymlink 9000/800. In addition to binary transfer, these programs can:
♦

Transfer data between an HP host text file and a Macintosh text file.

♦

Back up a Macintosh file to the HP host. An application or document
stored in this way can be restored to its original form on a
Macintosh.

♦

Back up an HP host file to a Macintosh disk. A file stored in this way
can be restored to its original form on any similar HP host. KSAM
and IMAGE files cannot be transferred.

The interaction between Tymlink on the HP host and MS92 on the
Macintosh provides other useful file transfer functions. Data can be
compressed during transfer to make the operation run faster. Control
character and 8-bit characters can be recoded for transfer over sensitive
networks.
When uploading text files with international characters, Macintosh
characters are automatically translated to the HP Roman 8 character set;
when downloading, Roman 8 is translated to Macintosh.
Also, file transfers are performed using the cyclic redundancy check
(CRC) error checking algorithm to ensure the validity of the data.
The MS92 for Windows and MS92 for Macintosh Tymlink programs are
compatible, so if you have both PC and Macintosh users on your system,
they can share the same copy of Tymlink.
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Installing Tymlink
A script that installs Tymlink on an HP3000 or HP9000 host is provided
with MS92. If there is already a copy of Tymlink on your system, use the
alternate procedure described under the following heading If Tymlink is
already on your system.

On the HP3000
To install Tymlink, do the following:
1. Run MS92.
2. Log on as MANAGER.SYS, or log on to another group and account
where you want to install Tymlink. If you are directly connected to
the host (rather than running over a LAN), your port must be
configured as TERMTYPE 10. If not add the TERM=10 parameter
to your :HELLO command when you log on.
:HELLO MANAGER.SYS;TERM=10

Note: Tymlink cannot be installed over a DS line. If you cannot
connect directly or over a LAN to the host machine, install Tymlink
on the local machine, then use DSCOPY to transfer Tymlink to the
host.
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3. If you are directly connected to the host, choose Connection from
the Settings menu. Ensure that parity is set to None/8 and that XON/
XOFF Output Control is disabled. No special configuration is
required if you are running over a LAN:
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4. Choose Do Script from the Script menu. In the dialog box displayed,
open the INSTALL.TTS file in the MS92 folder.

5. The script displays a message asking whether you are installing on a
HP3000 or a HP9000. Once you click HP3000, an informational
dialog box is displayed. When you click Install in this box, transmission begins.
6. If the procedure takes more than 10 minutes, it is likely that a
communications error occurred and operation has been suspended.
Click Cancel to terminate the transfer, and then restart the procedure.
7. If you install Tymlink in a group other than PUB.SYS, choose File
Transfer from the Settings menu and edit the Startup Sequence used
to run Tymlink in the File Transfer Settings box.
To ensure that there are no transmission errors, Tymlink is uploaded
twice, and the two versions are compared. If they are identical, installation is successful. One version is purged automatically. If they are not
identical, a message is displayed to inform you that the installation has
been unsuccessful. You should try again at a slower baud rate.
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Use the MPE SPEED command to adjust the baud rate on the host before
changing MS92’s baud setting:
:SPEED 240,240

Choose Connection from the Settings menu to change MS92’s baud rate.
Then type MPE at the colon prompt to enable the new baud rate:
:MPE

If you are performing the upload over telephone lines or a LAN and it
continues to fail even at the lowest baud rate, arrange to have installation
performed using a direct connection.

On the HP9000
If your HP9000 system has a copy of UMODEM, it is used to install
Tymlink. UMODEM is included with HP-UX on the Series 300 and, as
of HP-UX 7.0, on the Series 800. The path to UMODEM must be set in
your Unix environment variable PATH.
If you do not have UMODEM, MS92 attempts to transfer a small upload
program to your 9000 and uses this program to upload Tymlink. This
procedure requires a C language compiler. If you have neither
UMODEM nor a C compiler, please contact your Minisoft support
representative for assistance.
1. Run MS92.
2. Log in to the HP9000 as root (or otherwise become superuser).
Change to the /usr/bin directory:
cd /usr/bin

You must perform the upload while logged on in the Bourne shell.
3. Choose Connection from the Settings menu to ensure that parity is
set to None/8.
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If you are running over a LAN connection proceed with step 5.

4. The port attached to your HP9000 must also be configured for no
parity checking and eight stop bits. If it is not, use the stty -parenb
cs8 ixon ixoff command.
5.

Choose Do Script from the Script menu, and choose the script file
INSTALL.TTS in the dialog box displayed.

6.

The script displays a message asking whether you are installing on
an HP3000 or an HP9000. Once you click HP9000, an informational
dialog box is displayed. This box contains a button for the Series
300 and a button for the Series 800. Once you click Install, MS92
locates UMODEM on the HP9000 and proceeds with installation.
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7. To ensure that there are no transmission errors, Tymlink is uploaded
twice, and the two versions are compared. If they are identical,
installation is successful. One version is purged automatically. If
they are not identical, a message is displayed to inform you that the
installation has been unsuccessful. Poor line quality is most likely
the problem; you should try again.
8. If you install Tymlink in a group other than /usr/bin, choose File
Transfer from the Settings menu and edit the Startup Sequence used
to run Tymlink in the File Transfer Settings box.
If there is not a copy of UMODEM on your HP9000, MS92 uses its own
upload procedure. A small C language program called UPLOAD.C is
transferred from the MS92 folder on your Macintosh to the HP9000.
This program is compiled and run to transfer Tymlink from the
Macintosh to the HP9000. Once Tymlink has been successfully transferred, UPLOAD.C is purged.
If the transfer fails, attempt the upload at a lower baud rate. Reconfigure
your HP9000 port for a lower baud rate using stty <baudrate>, and set a
lower baud rate by choosing Connection from the Settings menu. If you
are performing the upload over telephone lines or a LAN to a remote
HP9000 and it continues to fail even at the lowest baud rates, you should
arrange to have the Tymlink installation performed by a Macintosh
connected directly to the HP9000.

7-8

Minisoft 92 for the MAC

Chapter 7: Installing File Transfer

If Tymlink is Already on Your System
If there is a copy of Tymlink installed on your host, you can install the
new version using the Send File command rather than by running the
INSTALL.TTS script. This is a faster and more secure approach. Do the
following:
1. Run MS92.
2. On the HP3000, log on as MANAGER.SYS, or log on to another
group and account where you want to install Tymlink. On the
HP9000, login as root (or otherwise become superuser) and change
the directory to /usr/bin or other directory where you want to install
Tymlink.
3. Choose Send File from the File menu.
4. Select the Tymlink file in the MS92 folder on your hard disk and
click Open. For the HP3000, select TYMLINK 3000; for the HP9000
select TYMLINK 9000/800.
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5. Since there is already a file named Tymlink in the group or directory
to which you are transferring, and since it can’t be replaced while it
is in use (you are running it right now), you must rename the new
Tymlink file before transferring it:

For TYMLINK, type a different name, such as TYMNEW.
6.

Click Send to start the transfer.

7. When the transfer is complete, purge the old copy of Tymlink and
rename the new one. On the HP3000, enter these commands:
:RENAME TYMLINK,TYMOLD
:RENAME TYMNEW,TYMLINK
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On the HP9000, rename the new version of Tymlink and give it
execute capability using the Unix command chmod.
mv tymlink tymold
mv tymnew tymlink
chmod +x tymlink

8. If you installed Tymlink in a group other than PUB.SYS or /usr/bin,
choose File Transfer from the Settings menu and edit the Startup
Sequence used to run Tymlink in the File Transfer Settings box.

Configuring the Defaults
To configure file transfer options, choose File Transfer from the Settings
menu.
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Before You Begin
This section provides instructions for transferring different files between
the Macintosh and a host computer. To transfer files with HP systems
using MS92’s built-in protocol, the Tymlink file transfer companion
program must be installed on the HP host. Depending on your data
communications hardware, some special configuration options may also
be required. You may need the help of your system manager to take care
of these things. For more information, see the File Transfer Installation
and Configuration chapter in this manual.
MS92’s built-in XMODEM facility does not require installation of
Tymlink.
An explanation of each option in the file transfer dialog boxes is found in
the chapter titled Menu Reference and in the on-line help system.
Note: Once you begin a file transfer with MS92, this status box is
displayed showing you the progress of the transfer:

Don’t worry if the Characters sent don’t match the File size in characters
once the transfer is complete because sometimes MS92 has to pad the
information transmitted to create transfer blocks of even length.
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Transfer any Type of File
to the HP3000 or HP9000
You can do a binary transfer with any type of file on your Macintosh or
host system except for Macintosh applications. In binary transfer, each
character in the input file is simply copied to the output file; no special
characteristics of the file such as HP file code and blocking factor or
Macintosh resource fork are preserved. For this reason, this approach is
not usually used to transfer program files, system files, or other host
specific files, as these files may be unusable after a binary transfer. To
transfer these types of files, see—in Chapter 8—Backup Macintosh Files
on the HP3000 or HP9000 and Back up HP files on the Macintosh; for
text files, see Transfer Text Files with an HP3000 or HP9000.
To perform a binary transfer, do the following:
1. Run MS92 and log on to the host.
2. Choose File Transfer from the Settings menu and make sure that the
right transfer method (MS92 to HP3000 or MS92 to HP9000) is
selected.
3. Select Send File from the File menu to transfer a file to the host.
Select Receive File to transfer a file to the Macintosh.
4. Select or type the name of the file to be transferred.
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5. The Transfer dialog box will then display. Check the name and any
other characteristics of the file created by the transfer. Make sure the
binary transfer option is selected.
Receive File

Send File

6. Click Send or Receive to start the transfer.
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Transfer Text Files with a
HP3000 or HP9000
To use MS92’s built-in transfer protocol to send a text file from the
Macintosh to the host or from the host to the Macintosh, follow the
instructions below.
1. Make sure the file to be sent contains text characters and tabs only,
no special formatting or fonts. Otherwise MS92 may not recognize
the file as a text file. For Macintosh files, save with the Text Only
option.
2. Run MS92 and log on to the host.
3. Choose File Transfer from the Settings menu.
4. If you are sending or receiving files from an HP3000/HP9000 select
the corresponding tab and select the necessary options:
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4. Select Send File from the File menu to transfer a Macintosh text file
to the host. Select Receive File to transfer a host file to the
Macintosh.
5. Select or type the name of the file to transfer.

6. One of the following dialog boxes is displayed:
When sending from the Mac to an HP3000:
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When receiving from an HP3000 to a Mac:

When sending from the Mac to an HP9000:

When receiving from an HP9000 to a Mac:

7. Verify that Text File is shown as the file type in the upper right of
the box. If not, click Cancel and make sure the file is in a text-only
format.
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8. Check the name and any other characteristics of the file created by
the transfer.
9. When transferring to or from an HP3000, choose either the word
wrap or retain lines option. Word wrap concatenates lines into
paragraphs until it encounters two consecutive carriage returns in a
Macintosh file or a blank line in an HP EDITOR file. Retain lines
preserves the line breaks of the file as they are.
10. Click Send or Receive in the dialog box to start the transfer.
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Backup Macintosh Files on the HP3000
or HP9000
You can transfer any type of Macintosh file to the HP3000 or HP9000 so
that it can later be restored on the Macintosh with all characteristics
preserved. Do the following:
1. Run MS92 and log on to the host.
2. Choose File Transfer from the Settings menu and make sure the
right transfer method (MS92 to HP3000 or MS92 to HP9000) is
selected.
3. Choose Send File from the File menu.
4. Select the Macintosh file to transfer.
5. The Transfer dialog box is displayed. Check the name of the file
created on the HP host by the transfer. Make sure the Backup
Macintosh file option is selected. Although Macintosh files can be
transferred to the host as binary files, they are usually unusable after
transfer. Macintosh application files can only be transferred as
backup files.
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6. Click Send to start the transfer.
To restore a Macintosh backup file, choose Receive File, and transfer the
file back to the Macintosh with the Restore Macintosh file option.
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Backup HP Files on the Macintosh
You can transfer any type of HP file to the Macintosh so that it can later
be restored on the original or another HP host. Use this method when
transferring program files and other files where blocking factors, file
codes, etc., must be maintained for the files to be useful when restored
on the HP system. Do the following:
1. Run MS92 and log on to the host.
2. Choose File Transfer from the Settings menu and make sure that the
right transfer method (MS92 to HP3000 or MS92 to HP9000) is
selected.
3. Choose Receive File from the File menu.
4. Type the name of the HP file to transfer.
5. The Transfer dialog box is displayed. Check the name of the file
created on the Macintosh by the transfer. Make sure the Backup HP
file option is selected.

6. Click Receive to start the transfer.
To restore this file on an HP3000, choose Receive File and transfer it
back to the host with the Restore HP file option.
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Send and Receive Files Using XMODEM
To use MS92’s XMODEM file transfer facility to send and receive data
with any other system that has an XMODEM program (on HP-UX
systems, the XMODEM program is called UMODEM), follow the steps
below.
To perform an XMODEM transfer:
1. Run MS92.
2. Choose File Transfer from the Settings menu. Make sure the MS92
to XMODEM transfer method is selected.
3. Log on to the host, and run its XMODEM program.
4. When sending or receiving a file with XMODEM, you must first tell
the host to send or receive the file, then have MS92 do the converse,
as described below.
5. Choose Receive File or Send File from MS92’s File menu.
Do this as quickly as possible, since the host program will probably
terminate if it does not receive transmission by the end of some
allotted period. If you time out, you must start over.
6. Select or type the name of the file to transfer.
7. Click OK to start the transfer.
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What Scripts Can Do
A MS92 script is a sequence of statements written in TermTalk, the
scripting language provided with MS92 for MAC. A script automatically
performs functions that would normally be performed by a user at a
terminal. For example, a script can:
♦

Log on to a host

♦

Set configuration values

♦

Run applications

♦

Transmit data to the host

♦

Create and delete files (on Macintosh or host)

♦

Log data and print files

♦

Send and receive files to and from other computers

♦

Prompt the user for input; display messages

♦

Take different actions in different situations.

This chapter tells you how to run scripts and gives some basic ideas
about how to use MS92’s command recorder. Please refer to the TermTalk Script Language Reference manual for complete details.

9-2

Minisoft 92 for the MAC

Chapter 9: Scripts

Run a Script Manually
or Automatically
If your system manager or another MS92 user has provided you with
scripts, all you need to know is how to run them. The simplest way is to
choose Do Script from the Script menu.
Use the controls in the dialog box displayed to locate and select the
script:

Then click Open.
While the script is running, use Stop Script or Pause Script from the
Script menu to interrupt execution. If you pause, choose Resume Script
to continue.
There are several ways to make running frequently used scripts more
automatic and convenient. See the following procedures.
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Add a Script to the Script Menu
To add a script to the script menu, do the following:
1. Choose Script from the Settings menu. The following dialog box is
displayed:

2. Click the Add button in the bottom half of the box.
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3. Select a script file in the dialog box displayed:

and click Open.

4. Click OK in the Script Settings box.

Minisoft 92 for the MAC

9-5

Chapter 9: Scripts

5. Next time you open the Script menu, your script is listed at the
bottom.

6. Be sure to save your Script menu listings by choosing Save or Save
As from the File menu to create a settings file. When you run MS92
by opening that file, the scripts you have specified appear on the
Script menu.
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Execute a Script when you Open or Close a
Settings File
To execute a script when you open or close your settings file:
1. Choose Script from the Settings menu.
2. Place the cursor in the Do when opening or Do when closing box.
Click the Select button.
3. Select a script file in the dialog box displayed, and click Open.
4. The script name (along with its location on disk) is displayed in the
box where the cursor was positioned:

5. The location of the script is saved along with the name so MS92 can
find it. If you move the script to another folder or disk, you must
remove it and re-add it.
6. Choose Save or Save As from the File menu to create a settings file.
When you open that settings file, the Do when opening script is
executed. When you close the file, the Do when closing script is run
before MS92 execution is terminated.
Minisoft 92 for the MAC
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Associate a Script with a Function Key
To execute a script with a function key, do the following:
1. Choose Function Keys from the Settings menu:

2. Choose Script in the Function column, and then click the Script
button at the bottom of the box to choose a script file. The name and
location of the script are placed in the String or Script box. In the
Label column, type one or two lines of eight characters or less
indicating the name of the script or its purpose.
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3. Save your function key definitions in a settings file by choosing
Save or Save As from the File menu.
Tip: Your function key definitions are removed when a host application loads its own function key values and labels. Since most
applications use only F1 - F8, you can avoid having some definitions
wiped out by putting them in F9 - F12. Also, you can reload function
keys saved in your settings file by choosing Revert from the File
menu. This won’t interrupt your host MS92. Finally, you could write
a TermTalk script that loads function key definitions, assign it to one
of the keys between F9 and F12 so that it doesn’t get wiped out, and
run that script whenever you need to reload the function keys.
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Record a Script
MS92’s automatic command recorder is useful for creating simple
scripts, for building a basic structure for more complex scripts that can
later be modified using the script editor, and for helping you learn to use
TermTalk. Turn on the recorder before performing a series of actions,
and the commands required to reproduce these actions are recorded
automatically. Follow these basic steps.
1. Choose Show Script Window from the Script menu. You may wish to
size the main window and the script window to make both visible on
your screen.
2. Start recording by choosing Record a Script from the Control menu
of the script window.
3. Click in the main MS92 window so that it becomes the active
window again.
4. Do the operation you want to record. Commands appear in the script
window as you perform each action.
5. Choose Stop Recording from the Control menu to suspend or stop
recording.
Choosing Record a Script again, recording resumes at the current
cursor position.
6. You can edit the script in the window at any time (even without
stopping recording), and can save it with the Save or Save As
commands from the File menu.
If you record complex interactions with host software, the resulting
script is likely to require editing to fine-tune timing and handshaking
procedures. You may need to use the TermTalk expect command to
condition the sending of data upon the reception of the appropriate
prompt from the host. When adding commands to the script, it is convenient to use the Paste command from the Edit menu of the script window
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to place the default syntax of the command in the window. Edit the
command parameters as required.
To record a script without displaying the commands on the screen, start
recording from the Script menu of the main window rather than from the
Control menu of the script window. Follow these steps:
1. Choose Record A Script from the Script menu.
2. Do the actions you wish to record. MS92 records data typed from
the keyboard, menu, and dialog box selections, configuration
settings, and changes in window size and position.
3. To suspend recording at any point, choose Pause Recording from
the Script menu. This item then changes to Resume Recording.
When you resume recording, commands are appended to the end of
the file where you left off.
4. When finished, choose Stop Recording from the Script menu. Save
your script by specifying a name in the dialog box displayed.
5. To see the script you created, open the script window by choosing
Show Script Window from the Script menu. Open your script file by
choosing Open from the script window’s File menu. You can then
test your script using Do Script Window, Do Line, and Do Selection
from the Control menu of the script window and edit it as necessary.
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Write a Startup Script
A start-up script is run automatically when you open the settings file it is
associated with. To designate a start-up script, see Execute a script when
you open or close a settings file on page 7-4. The paragraphs below gives
you some ideas about how to create a script used for this purpose.
A start-up script can contain commands to log on to the host, set configuration values, run an application, and so forth. A sample start-up script
for the HP3000 is shown below:

To create a start-up script like this, you might turn on command recording before performing your normal log on procedures. Each time you
press Return, the sendline “” command is recorded automatically. Typing
your log on would be recorded as with the sendline command.
However not all elements of the script can be created automatically by
the command recorder. To prompt for a password in a dialog box rather
than just sending it with a sendline command, you would have to add the
input command manually. (This would eliminate the need to place
passwords in a script file where other users could see it, and also would
make it unnecessary to update the script if the password changed.)
Manual modifications can be made by editing the script in the script
window after you finish recording.
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The set commands that establish labels and values for F1 and F2 could
be created using the command recorder. You would turn on recording
before you select Function Keys from the Settings menu and enter the
data. The settings are recorded using the commands shown in the sample
script.
Similarly, the set maximizeSize and set logDirection commands are
recorded when you open the Terminal and Logging Settings boxes and
make the corresponding choices.
In general, most configuration options can either be saved in a settings
file or set by a start-up script. However, there are some settings that
cannot be made by a script and must be saved in a settings file. These
include:
♦

All Color Settings options

♦

All Display Enhancement options

♦

Scripts to be added to the Script menu

For further details on using TermTalk, see the TermTalk Reference
Manual.
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Overview
There are three ways to connect a Macintosh to an HP3000 host:
♦

With a direct cable

♦

Using a modem

♦

Through a LAN connection.

This section gives instructions for each type of connection.

Direct Connection
Macintosh 512KE
To cable a Macintosh 512KE to a host system, you need a cable at the
Macintosh end that conforms to one of the following diagrams. You can
connect this cable to either serial port A (the modem port) or serial port
B (the printer port).
Serial connection is MS92’s default connection type. If you have any
problems getting a host prompt, do the following:
1. Choose Connection from the Settings menu.
2. Ensure that Serial is selected.
3. Click the Options button to verify other parameters.
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ADCC port controller - RS-232

Connection of pin 7 on the DB-9 to pin 20 on the DB-25 is required only
if you plan to use the Hardware DTR Hangup option in the Connection
Settings box (choose Connection from the Settings menu). To use this
option, you must have a 512KE or larger system.
DB- 9

DB- 25

3

7

5

2

9

3

7

20
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ATP (3-pin) port controller—RS-232

The above illustration shows a DB-9 connector, front view (Mac) and a
DB-3 connector, back view - solder side (HP).
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ATP (5-pin) port controller—RS-422

The above illustration shows a DB-9 connector, front view (128K or
512K Mac), and a DB-5 connector, back view - solder side (HP3000).
DB- 9

DB- 5

1

1

4

4

5

2

8

5

9

3
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98624A MUX on HP9000 Series 3000

The above illustration shows a DB-9 connector, front view (128K or
512K Mac), and a RJ-11 connector. The RJ-11 has 6 positions but only
the inner 4 are used. Pins are numbered from left to right looking into the
socket, with the locking tab up toward the observer.
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Other Macintoshes
The following diagrams show how to cable the DIN-8 connector on a
Macintosh Plus, SE, LC, II, etc., to the connector for the HP host system.

ADCC port controller—RS-232

The above illustration shows a DIN-8 connector, front view (Mac), and a
DB-25P connector, back view - solder side (HP).
DINI- 8

RJ- 11

3

2

4

7 (jumpered to 1)

5

3

1

20

Connection of pin 1 on the DIN-8 to pin 20 on the DB-25 is required
only if you plan to use the Hardware DTR Hangup option in the Connection Settings box (choose Connection from the Settings menu).
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ATP (3-pin) port controller - RS-232

The above illustration shows a DIN-8 connector, front view (Mac Plus),
and a DB-3 connector, back view - solder side (HP3000).
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ATP (25-pin to 5-pin) port controller—RS-422

The above illustration shows a DIN-8 connector, front view (Mac), and a
DB-25P connector, back view - solder side (HP).
DIN- 8

DB- 25

3

9

4
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5
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8
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ATP (5-pin) port controller—RS-422

The above illustration shows a DIN-8 connector, front view (Mac Plus),
and a DB-5P connector, back view - solder side (HP3000).
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98624A MUX on HP9000 Series 3000

The above illustration shows a DIN-8 connector, front view (Mac Plus),
and a RJ-11 connector. The RJ-11 has 6 positions but only the inner 4 are
used. Pins are numbered from left to right looking into the socket, with
the locking tab up toward the observer.
DIN- 8

RJ- 11
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Modem Connection
To connect a modem to a Macintosh, follow the instructions from the
modem manufacturer. To configure MS92 to use the modem connection,
do the following:
1. Choose Connection from the Settings menu.
2. Select Modem from the Connection Type pop-up menu.
3. Type the phone number in the Phone Number box.

To dial, choose Connect from the File menu.
To hang up (works with Hayes-compatible modems only), choose
Disconnect from the File menu.
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When Hayes-compatible modem is selected in the Connection Settings
dialog box and you choose Connect from the File menu, MS92 sends the
commands required to set up and hang up the modem automatically.
When you select Connect, the following commands are transmitted:
ATZ

Resets the modem.

ATE0

Turns echo off.

ATQ0

Modem sends result codes

ATV1

Results are words.

ATS5=255

Disable backspace character.

ATS12=2

Set escape guard time to 40 milliseconds.

ATM1

Turns speaker on only while connecting.

ATD[T/P] phone#

Dials the phone number entered in the Connection Settings box. T
indicates tone dialing; P indicates pulse.

A/

Used to redial the phone number if Redial Until Connected is
checked in the Connection Settings box.

When you select Disconnect, MS92 sends the commands below:
+++

Puts modem in local command mode.

ATH

Hangs up.

ATZ

Resets the modem.

If you are using a modem that is not Hayes-compatible, you must enter
the setup, dialing, and hangup commands manually. Setup and dialing
commands can be included in the phone number string entered in the
Connection Settings box. Strings that contain multiple carriage returns
cannot be entered in this box and must be typed from the keyboard.
Pause characters (,) can also be entered in the phone number, if necessary.
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LAN Connection
Hardware and Software Compatibility
With MS92, you can connect a Macintosh to an HP3000, HP9000, or
other ARPA Telnet host using an Ethernet local area network (LAN).
MS92 currently supports a wide range of Ethernet adapters. Ethernet
adapters can be cards installed directly in your Macintosh or external
boxes connected using the SCSI port on the Macintosh. All Ethernet
adapters are shipped with software drivers that must be installed in the
System folder of your Macintosh before using MS92.
MS92 also lets Macintosh use a LocalTalk to Ethernet gateway such as
the Shiva (Kinetics) FastPath or the Cayman Gatorbox. This means a
group of Macintoshes connected to a LocalTalk network can access a
host computer on an Ethernet network through the gateway. With a
gateway you don’t need a separate Ethernet adapter card for each Mac.
Use of gateways requires that your HP host be configured for Ethernet.
On an HP3000, use NMMGR.PUB.SYS to enable Ethernet as a link
level transport service. The Ethernet and the 802.3 protocols run in
parallel with the computers figuring out which to use for a particular
terminal conversation.
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♦

Only MPE V systems running V D 5 or later support Ethernet.

♦

MPE XL 2.1 does not support Ethernet, but versions 2.2 and later do.

♦

All HP hosts support the 802.3 protocol.

♦

Most UNIX hosts automatically support gateway connections using
Telnet.
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Establishing LAN Connection
Follow these steps to establish a connection between a Macintosh and
the HP3000 host systems using a LAN. You may need the help of your
system manager or network administrator.
1. Run MS92 and choose Connection from the Settings menu. Select
the NSVT or Telnet option from the Connection pop-up menu:

2. NSVT is usually used for HP3000 hosts, and Telnet for HP9000 or
ARPA hosts.
3. Enter the node name of the host to connect to and click OK.
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The node name can be:
-

Any host name set up in the SESSION.HOSTS file

-

Any name that can be resolved using a domain name server on
the network

-

The full Internet address, for example, 192.6.1.5.

-

A pound sign (#) followed by the host number used by the host
on your Ethernet. The pound sign is used only when the
Macintosh and the host are on the same Ethernet. The host
number is determined by the class of addressing and the subnet
mask. For example, if your Macintosh is at address 192.6.1.55,
you can access host 192.6.1.5 by entering #5.

4. MS92 locates the Ethernet card and establishes a connection to the
host. A host prompt appears in the MS92 window within a few
seconds.
5. To terminate the connection, choose Disconnect from the File menu.
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SESSION.HOSTS File
The hosts file (SESSION.HOSTS) contains local operating parameters
such as your node name and IP address, plus a list of commonly accessed
hosts and optional network tuning parameters for each one.
SESSION.HOSTS is a TeachText document and can be edited with the
TeachText application or with any word processor or text editor.
The SESSION.HOSTS file must be located in the folder containing
MS92 or in your System Folder. MS92 uses the SESSION.HOSTS file in
your System Folder if it finds one there first. The file is listed on the
following pages. An explanation of the syntax and meaning of each entry
follows.
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#

This is a text file containing network configuration options.

#

You must replace the sample values shown with actual values for your network!

#

Check with your network administrator if you need assistance.

#####################################################################
#

Set these parameters equal to your Mac's IP address and network name.

#####################################################################
myip=192.6.1.173
myname=mikemac.domain.organization
#####################################################################
#

Set your Ethernet adapter type: AppleTalk, Ether, EtherSE, EtherSC

#####################################################################
hardware=Ether
zone=*
#####################################################################
#

For Ethernet connection, set maximum time in seconds to spend locating host address.

#####################################################################
arptime=5
#####################################################################
#

If you use 802.3 protocal rather than standard Ethernet, remove the comment symbol

#

at the beginning of the next line.

#####################################################################
# 802p=1
#####################################################################
#

To set up a name to use instead of the IP address and to establish TCP/IP tuning options

#

edit the entries below. the first set of entries establishes defaults for all machines.

#####################################################################
name=default # Don't change this line
contime=20
# how long to attempt to make connection, in seconds
retrans=30
# how long to wait before resending an unacknowledged packet,
# in ticks (1/60th second)
mtu=512 # maximum transmit unit in bytes
# For Apple Talk, mtu<=512. For Ethernet, mtu<=1024
maxseq=512 # largest segment we can receive
# For Apple Talk, maxseq<=512. For Ethernet, maxseg<=1536
rwin=4096
# TCP window size. Must be <=4096
#####################################################################
#

Create a set of entries for each machine used. You can simply establish a name for each

#

host or you can override default tuning options. For example:

#####################################################################
name=s825 ; hostip=192.6.1.2
name=xe ; hostip=192.6.1.5; contime=50
name=s70; hostip=192.6.1.3 ; gateway = 1

10-18

Minisoft 92 for the MAC

Chapter 10: Connecting to the Host

Syntax for Entries in SESSION.HOSTS
The file is a list of entries, each composed of a keyword and a value for
that keyword. Any of the following delimiters can be used between
entries or between a keyword and its value:
♦

Equal sign (=)

♦

Colon (:)

♦

Semicolon (;)

♦

Any white-space character (for example, space, carriage return, line
feed, tab).

In the following example of correct syntax, the equal sign is used between each keyword and its value. A carriage return is used between
entries.
name=hostname
hostip=192.6.1.10
contime=60

# comment field to end of line ->

In the next example, a colon is used between each keyword and its value,
and a space is used between entries.
name:hostname hostip:192.6.1.10 contime:60

To include delimiters in a value field, enclose the field in quotes. Quotes
cannot be a part of any value. Pound signs (#) indicate comments. Once a
pound sign is entered, everything from the pound sign to the end of line
is a comment.
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Macintosh HOSTS File
The first entries in the file describe the Macintosh environment.
myip Set this entry to the IP address of your Macintosh. This address
must be unique on your network. To use dynamic IP addressing, see
Dynamic IP addressing below.
myname Set this entry to the network name of your Macintosh. It must
be unique on your network. This name should include the domain and
organization names.
hardware Set this entry to one of the following values, depending on the
type of hardware you are using to make LAN connections:
Ether

Ethernet card in a Mac II type system

Ether

For Macintoshes with built-in Ethernet connections
(Quadra and Centris) who want to use an added
Ethernet card, nn is 10 for slot 1, 11 for slot 2, 12 for
slot 3, etc.

EtherSC

SCSI-based Ethernet adapter

EtherSE

SE bus Ethernet adapter card

AppleTalk

LocalTalk to Ethernet gateway (Shiva FastPath,
Cayman Gatorbox, etc.)

zone=* This entry is used with hardware=AppleTalk to indicate which
LocalTalk zone the Ethernet-to-LocalTalk gateway is in. The default,
zone =*, means the gateway is in the same zone as your Macintosh. If the
gateway is in another LocalTalk zone, set this entry equal to the name of
that zone in quotes; for example, zone=”Marketing Macs”. Using a
gateway in a zone other than the one your Macintosh is in requires that
you also specify myip=dynamic. See heading Dynamic IP addressing.
netmask If your site uses a subnetted network, you may enter a subnet
mask in decimal form using this parameter; for example,
netmask=255.255.255.0.
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arptime Set this entry to the number of seconds to spend trying to locate
the host’s address on your network. Five seconds works fine for many
networks, but larger values may be needed for hosts slow to respond.
Smaller values are more convenient for the user since the time-out period
is shorter.
802p=1 This entry indicates whether to use 802.3 protocol or standard
Ethernet protocol to connect with your host.
♦

If you are using AppleTalk Phase 2 on your Macintosh and connecting to a host supporting Ethernet, use the Ethernet protocol in MS92.

♦

If you are using AppleTalk Phase 1 on your Macintosh, or connecting to a host that only supports 802.3, use the 802.3 protocol in
MS92.

To use 802.3 protocol, remove the comment symbol (#) before the
802p=1 line. To use Ethernet protocol, either remove this line or leave
the comment symbol.

Host-Specific Parameters
After the Macintosh configuration options, you may list zero or more
hosts, with specific parameter values for each one. Typically, the first
host listed is name=default. The entries for this host establish default
values for all hosts. Any keyword listed under later hosts overrides the
default setting.
Note that the keyword name is special because it separates entries.
Parameters following a name up to the next name are all associated with
the specified host.
name Set this entry either to default or to the name of a host to which
you want to connect. This name can be used as a shortcut when connecting to this host, instead of typing the IP address.
hostip Set this entry to the IP address of the host. For efficiency, include
the IP addresses of all commonly accessed hosts. IP addresses of gateways and servers are required entries in the configuration file. See also
Dynamic IP addressing below.
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gateway Set this entry to the gateway precedence for this host. To reach
hosts that are not connected to your local network, at least one gateway
entry is required. Gateway numbers must start at 1 and increase by
increments of 1.
contime Set this entry to the number of seconds to spend trying to open
the connection. After this amount of time has elapsed, MS92 gives up on
opening the connection. For congested or slow networks, this value
should be increased.
retrans Set this entry to the initial retransmit time-out in 1/60ths of a
second. After each packet of data is transmitted, MS92 waits for an
acknowledgment. If none is received, the packet is retransmitted. This
entry specifies how long MS92 waits for an acknowledgment before
retransmitting. Increasing its value helps avoid unnecessary retries when
using connections with high round-trip times.
mtu Set this entry to the size in bytes of the maximum transmission unit;
that is, the largest amount of data to put in each packet. If you are
sending to the ARPANET or to local hosts, use mtu=512. Do not set a
value greater than 512 with a LocalTalk to Ethernet gateway.
maxseg Set this entry to the size in bytes of the largest segment that can
be received. This value controls the size of the packets that are sent over
the connection. Reducing this value can eliminate IP fragmentation. A
value of maxseg=512 should be sufficient to avoid fragmentation. Do not
set a value larger than 512 if you are using a LocalTalk to Ethernet
gateway.
rwin Set this entry to the size of the receive window in bytes. The
Ethernet hardware MS92 uses cannot handle receiving back-to-back
packets. This requires us to limit the TCP receive window advertised to
other hosts. For communicating to slower hosts, a larger window may
work better. 4096 is the maximum setting.
copyfrom Set this entry to the name of a previously specified host from
which you want to copy all unspecified parameters.
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Dynamic IP Addressing
To have MS92 request a dynamic IP address from a KIP-style gateway
such as a Fastpath or Gatorbox, specify myip=dynamic. The gateway
must be configured to allow this; see your gateway manual for details.
Alternately, you can pre-assign an IP address using the codes shown in
Table 2. When you attempt to connect to a gateway, MS92 decodes the
address you specify and replaces it with a numeric value, as shown in
Table 3. Because these addresses are assigned by MS92 rather than by
the gateway, this type of addressing doesn’t require special configuration
of the gateway. From the gateway’s perspective, these addresses are
static addresses.

Codes for IP addressing
Code

M e aning

h

High- order byte of the network number (net number/256)

l

Low- order byte of the network number (net number modulo 256)

n

AppleTalk node number

Some examples are shown below:

Sample IP addresses
IP Addre s s

Apple Talk Numbe r

Re s ulting IP Numbe r

myip=128.174.h.n

Net:1230 Node:35

128.174.4.35

myip=128.174.20.n

Net:1230 Node:35

128.174.20.35

myip=m80.h.l.n

Net:1230 Node:35

128.4.206.35
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Multiple Sessions
There are as many ways to set up and run multiple simultaneous sessions
as there are network configurations and users, but here are a few guidelines that need to be observed:
♦

Each simultaneous MS92 requires a separate copy of the MS92
product.

If you are using MS92 4.12 or later, the number of simultaneous sessions
you can run is limited only by your available RAM and disk space.
Our recommendation for setting up and running multiple sessions
follows:
1. Create a folder for each MS92 you intend to run.
2. Make a duplicate copy of MS92 for each folder, naming it something descriptive (like the network connection it will use, or the
name of the host you’ll be connecting to).
3. Place each copy in its own folder.
4. For each copy of MS92, create a settings file (named MS92 Defaults) with the appropriate connection settings, window placement,
screen colors, f-key definitions, scripts, etc. Place this file in the
folder with its copy of MS92.
Naming the settings files MS92 Defaults ensures that when MS92
opens, it uses the settings in that file.
5. Create an alias for each MS92 application on your desktop. This
way, to run MS92 with a given connection configuration, all you
have to do is open the appropriate alias, and you’re ready to go.
NSVT is usually used for HP3000 hosts and Telnet for HP9000 or ARPA
hosts.
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Appendix A: Escape Sequences

Escape sequences are codes that allow executing programs to perform
terminal control functions. Most can be performed by entering them from
the keyboard. All escape sequences begin with the escape character
followed by one or more characters.
When a sequence is more than one character long and ends in a letter,
that letter must be uppercase. Sequences in the same family (with the
same two characters following the Ec character) can be combined. In this
case, the final letter must be uppercase and all preceding letters must be
lower case. For example, Ec&k1L turns on local echo and Ec&k1C turns
on caps lock. To combine these, you could use Ec&k1l1C or Ec&k1c1L.
In the tables following, escape sequences are grouped in functional
categories.
♦

The column labeled EC gives the characters that follow the initial
escape character in a particular sequence. Variables enclosed in
brackets (<>) should be replaced by a value. Where double brackets
are used (<<>>), the value should appear in brackets in the actual
sequence. For example, one valid form of Ec&p<<fn>>n9^ would be
Ec&p<RECEIPTS>n9^.

♦

The column labeled Function describes what the sequence does.

The remaining columns give keyboard, menu, and mouse equivalents
where available.
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HP700/92 and 700/94 Escape
Sequences
Terminal Control
EC Function

Ke yboard

M e nu

M ous e

1

Set tab stop

Margin/ tab ruler

2

Clear tab stop

Margin/ tab ruler

3

Clear all tab stops

I

Horizontal tab

TAB

i

Back tab

SHIFT TAB

4

Set left margin

Margin/ tab ruler

5

Set right margin

Margin/ tab ruler

9

Clear all margins

E

Hard reset

command key R

Utility

Press
ALT/OPTION and
click RESET

g

Soft reset

command key -

Utility

Click RESET

Y

Begin display function
mode

Utility

Z

End display functions
mode

Utility

b

Unlock keyboard

Settings,
Utility
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A-4

EC

Function

Ke yboard

M e nu

c

Lock keyboard

Settings,
Utility

&k0A

Disable auto line feed mode

Utility

&k1A

Enable auto line feed mode

Utility

&k0C

Disable caps lock mode

&k1C

Enable caps lock mode

&k0D

Disable bell

Settings

&k1D

Enable bell

Settings

&k0K

Disable auto keyboard lock

Settings

&k1K

Enable auto keyboard lock

Settings

&k0L

Disable local echo

Settings

&k1L

Enable local echo

Settings

&k0M

Disable Modify All mode

&k1M

Enable Modify All mode

&k0P

Disable caps mode

CAPS/LOCK

&k1P

Enable caps mode

CAPS/LOCK

&k0Q

Disable Click

&k1Q

Enable click

&k0R

Disable remote mode (local
mode)

Utility,
Settings

&k1R

Enable remote mode

Utility,
Settings

M ous e
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EC

Function

&k0]

Select key = Print/Enter
key

&k1]

Print/Enterkey = Select
key

&f1m149P<!154>

Return key = Enter key

Settings

&f1m149P<!149>

Return key = Return key

Settings

&f1m149P<>

Return key = Return key

Settings

&fR and &f2
11P...

Numeric keypad
Tab assignments

&f0B

Store configuration values,
function key labels, tabs
and margins for later
retrieval

&f1B

Restore values stored by
EC &F0B

z

Initiate terminal self- test

&q0L

Unlock configuration

&q1L

Lock configuration

&k<x>j

Selects CRT refresh rate

&k1\

Selects EM220 mode
from HP mode

&k0\

Selects HP mode from
EM220 mode
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Cursor Control

A-6

EC

Function

*d0Q

Underline cursor

Settings

*d1Q

Block cursor

Settings

A

Cursor up

UP arrow

Click on
spot

B

Cursor down

DOWN
arrow

Click on
spot

C

Cursor right

RIGHT
arrow

Click on
spot

D

Cursor left

LEFT
arrow

Click on
spot

H

Cursor home up

HOME

Click
Home Up

h

Cursor home up
(ignore transmit fields)

HOME

Click
Home Up

END

Press
ALT/
OPTION
and click
Home Up

F

Cursor home down

G

Cursor to left margin

'

Sense relative cursor
position

a

Sense absolute cursor
position

&a<col>c<row>Y

Move cursor to row
and col on screen
(screen relative
addressing)

Ke yboard M e nu

M ous e

Click on
spot

NOTE
The leftmost column
and topmost row are
numbered 0.

Click on
spot
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EC

Function

Ke yboard M e nu
NOTE

&a<col>c<row>R

Move cursor to
row and col in
display memory
(absolute
addressing)

&a±<col>c±<row>
Y

Move cursor
relative to its
present position on
screen

NOTE
Possitive numbers indicate
Click
right or upward movement;
on spot
negative numbers indicate left
or downward movement.

&a±<col>c±<row>
R

Move cursor
relative to its
present position in
display memory

NOTE
Possitive numbers indicate
Click
right or upward movement;
on spot
negative numbers indicate left
or downward movement.

&x0C

Disable send cursor
position mode

&x1C

Enable send cursor
position mode
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Display Control

A-8

EC

Function

Ke yboard

M e nu

M ous e

&w12F

Turns on display

&w13F

Turns on display

S

Roll up

SHIFT UP
arrow

Click up arrow

T

Roll down

SHIFT DOWN
arrow

Click down arrow

U

Next page

PAGE DOWN

Click scroll bar

V

Previous page

PAGE UP

Click scroll bar

EC

Function

Ke yboard M e nu

M ous e

&w6f<x>X

Select width of display in
columns (x=80,132,160)

*d0E

Normal display

*d1E

Inverse display

&k0[

Disable smooth scroll

Settings

&k1[

Enable smooth scroll

Settings

l

Begin memory lock mode

Settings, Utility

m

End memory lock mode

Settings, Utility

Settings
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Editing
EC

Function

Ke yboard

M e nu

M ous e

J

Clear from cursor to
end of memory

command k ey J to
CLEAR

Edit

Click Clr
Disp

K

Clear from cursor to
end of line

command k ey L or
SHIFT CLEAR

Edit

Click Clr
Line

L

Insert one line

command k ey I

Edit

Click Ins
Line

M

Delete one line

command k ey D

N

Begin insert character
with wraparound mode

O

Delete one character
with wraparound

Edit

Click Del
Line
Press and
click Ins
Char

EC

Function

Ke yboard

M e nu

M ous e

P

Delete one character

command k ey
E or DEL

Edit

Click Del
Char

Q

Begin insert character mode

SHIFT
INS/HELP

Edit

Click Ins
Char

R

End insert character mode

SHIFT
INS/HELP?

Edit

Click Ins
Char

&s0B

Disable SPOW

&s1B

Enable SPOW

&s0C

Enable EOL wrap

Settings

&s1C

Disable EOL wrap

Settings
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Format Mode

A - 10

EC

Function

M e nu

W

Begin format mode

Settings, Utility

X

End format mode

Settings, Utility

6

Define alpha field

7

Define numeric field

8

Define field

[

Begin unprotected field

{

Start transmit- only field

]

End field

&k0X

Select US decimal type

&k1X

Select European decimal type

&k<x>Y

Select <x> decimal digits

&k0Z

Disable transmit modified data mode

&k1Z

Enable transmit modified data mode
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EC

Function

&e<x>e<y>

Initiates edit check, applying attribute y
to field type x

&a<coll>s <col2>s...
<coln>s

Splits display memory veritcally into up
to 80 tab regions

&a<col1>s <col2>s...
<coln>s <row1>I

Specifies vertical tab regions for a range
of rows beginning at the top of display
memory and ending with row 1

&a<row1>i<col1>s
<col2>s... <coln>S

Specifiies vertical tab regions for a range
of rows beginning with row1 and ending
at the bottom of display memory

&a<row1>i<col1>s
<col2>s... <coln>s <row2>I

Specifies vertical tab regions for a range
of rows beginning with row1 and ending
with row2
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Forms Cache
EC

Function

&q4te2{<x>L

Set forms cache size
x = # of 256- byte blocks; 0£x£95

&p9^

Returns number of 256- byte blocks assigned
to forms cache

&p<x>p9^

&p<<fn>>n9^

Returns forms cache status,
where x is the form number and
fn is the form name

A - 12

&p<>n9^

Returns numbers and names of forms in forms
cache directory

&p9u<x>p0L
&p9u<x>pL

Purges form x

&p9u<x>pF

Copies form x from cache to screen

&p9u<<fn>>n <x>p<def>L

Defines and downloads form x of length y,
with name fn and definition characters def

&p9u<<fn>>n <x>p<<def>>L

Defines and downloads form x with name fn
and definition characters def. Used when
length is unknown.
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Status
EC

Function

^

Returns primary status

~

Secondary status request

*s^

Returns terminal id: 70092 or 70094

*s<x>^

Returns terminal capabilities
x=- 1 Alphanumeric capabilities
x=- 2 Graphics capabilities
x=- 3 Amount of RAM
x=- 4 Interface capabilities

*y^

Returns downloadable character set capabilities

&p4^

Returns printer status

Data Transfer
EC

Function

f

Disconnect modem

@

Stop transmission from terminal for one second

d

Transmit block to host

&k0B

Disable block mode

Settings, Utility

&k1B

Enable block mode

Settings, Utility

&k0I

Data byte = 7 data bits and one parity bit

Settings

&k1I

Data byte = 8 data bits, no parity bit

Settings

&s0A

Disable transmit functions mode

Settings

&s1A

Enable transmit functions mode

Settings
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A - 14

EC

Function

M e nu

&s0D

Disable page mode

Settings

&s1D

Enable page mode

Settings

&s0G

Enable handshaking

Settings

&s1G

Disable handshaking

Settings

&s0H

Disable DC2 handshaking

Settings

&s1H

Enable DC2 handshaking

Settings

&s1N

Disable esc transfer

&s1N

Enable esc transfer

&s0C

Disable send cursor position mode

&s1C

Enable send cursor position mode

&q8te 1 {0R

Return key = Return

Settings

&q8te 1 {1R

Return key = Enter

Settings

&q1te 1 {0G

Disable XON/XOFF Output Control

Settings

&q1te 1 {1G

Enable XON/XOFF Output Control

Settings

&q1te 1 {0H

Disable XON/XOFF Input Control

Settings

&q1te1 {1H

Enable XON/XOFF Input Control

Settings

&q<m>te 1 {0B

Disable hardware handshaking
m=1 Datacomm port
m=2 Printer port

&q<m>te 1 {1B

Enable hardware handshaking

&q4te2{0Z

For format mode transfers, transmit all
unprotected fields to host

&q4te2{0Z

For format mode transfers, transmit only fields
whose MDTs are set on
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Logging
Note: MS92 does not support selection of the destination device using
an escape sequence. No matter which device code you specify in your
escape sequence, data is always logged to a temporary log file on disk.
You can send the contents of the log file to the printer at any time using a
special sequence, Ec&opP.
EC

Function

0

Home up and copy memory to log file

&pB or &p0B

Copy line to log file

Log

&pF or &p0F

Copy from cursor line to last displayed
line to log file

Log

&pM or &p0M

Copy all of memory to log file

Log

&p<x>p1C
&p<x>p4u1C
&p<x>p6u1C

Perform x lines feeds

&p<x>C
&p4u<x>C
&p6u<x>C

Perform form feed; x = 0 or 2 - 10

&p11C
&p4u11C
&p6u11C

Enable logging from bottom

Log, Settings

&p12C
&p4u12C
&p6u12C

Enable logging from top

Log, Settings

&p13C
&p4u13C
&p6u13C

Disable logging

Log

&p<char>p20C

Enable record mode; char is the ASCII
value used to end record mode

&p<x>D

Select <x> as the destination device

Minisoft 92 for the MAC
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A - 16

EC

Function

M e nu

&p<y>D

Copies y amount of data to log file
y=b Copies the cursor line
y=f Copies from cursor line to last display line
y=m Copies from cursor line to end of display
memeory

&p<x>W<string>

Transfers x bytes of the string to the log file in
binary form 1£x£256

&p W<string>

Transfers string to the log file in ASCII form; string
is terminated by 256th byte or line feed character
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Function Keys
EC

Function

Ke yboard

M e nu

M ous e

p

Default for user key 1

F1

Keys

Click lable 1

q

Default for user key 2

F2

Keys

Click label 2

r

Default for user key 3

F3

Keys

Click label 3

s

Default for user key 4

F4

Keys

Click label 4

t

Default for user key 5

F5

Keys

Click label 5

u

Default for user key 6

F6

Keys

Click label 6

v

Default for user key 7

F7

Keys

Click label 7

w

Default for user key 8

F8

Keys

Click label 8

j

Begin user key definition

Settings

k

End user key definition

Settings

&j@

Enable user keys; remove key labels
and status line from the screen

&jA

Enable and display the Modes keys
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A - 18

EC

Function

&jB

Display user function key labels

&jR

Enable the User/System key

&jS

Disable the User/System key

&j<x>L
<message>

Remove key labels; display message
with length of x characters, up to 160

&jC

Remove message; display function key
labels

&j<x>D

Controls what happens after message
is displayed using
Ec&j<x>L<message> sequence
x=0 No bell, no CR transmitted,
labels restored
x=1 Bell rings, no CR transmitted,
labels restored
x=2 No bell, CR transmitted, labels
not restored
x=3 Bell rings, CR transmitted,
labels restored

&f<attr>a
<key>k
<lbllen>d
<strlen>L
<label>
<string>

Define function key attributes, labels,
and strings
attr=0 Normal
attr=1 Local
attr=2 Transmit
key
number of function key
1<key<8
lbllen number of characters in label
(maximum 16 used)
strlen number if characters in string
(Maximum 80 used)

&f<key>E

Executes a function key
key number of function key
1<key<8

Ke yboard

M e nu M ous e
Keys
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Display Enhancements
EC

Function

&d@

End display enhancement

&dA

Start blinking enhancement

&dB

Start inverse enhancement

&dC

Start inverse and blinking enhancement

&dD

Start under line enhancement

&dE

Start underline and blinking enhancement

&dF

Start underline and inverse enhancement

&dG

Start underline, inverse and blinking enhancement

&dH

Start half- bright enhancement

&dI

Start half- bright and blinking enhancement

&dJ

Start half- bright and inverse enhancement

&dK

Start half- bright, inverse and blinking enhancement

&dL

Start half- bright and underline enhancement

&dM

Start half- bright, underline and blinking enhancement

&dM

Start half- bright underline and inverse enhancements

&dO

Start half- bright, underline, inverse and blinking enhancements

&dS

Start security enhancement
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Character Set

A - 20

EC

Function

M e nu

)@

Change alternate set to base set

Settings

)A

Change alternate set to math set

Settings

)B

Change alternate set to line drawing set

Settings

)E

Change alternate set to italic set

Settings

)F

Change alternate set to bold set

Settings

)X

Download alternate set
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MS92-Specific Escape Sequences
The following table lists sequences used only with MS92. These control
script execution, file transfer, etc.
EC

Function

&ox<script>

Execute complied TermTalk script

&oX <scriptobject>

Execute TermTalk script object under NewWave

&oC<command>

Execute TermTalk command string y; no
completion status returned

&oB<command>

Execute TermTalk command string; completion
status returned

&os<x>h<mpefilename>N

Send a New Wave object to an HP3000 host
x length in characters of MPE file name

&or<x>h<mpefilename>N

Receive a file from an HP3000 host under
NewWave
x length in characters of MPE file name

&os<x>h<mpefilename>Z
&os<o>c <x>h<mpefilename>Z

Send
x
o=0
o=1
o=2
o=3
o=4
o=5

&or<x>h<mpefilename>Z

Receive a file from an HP3000 host under
Windows
x
length in characters of MPE file name
y
length in characters of MS- DOS file name

&or<y>w<msdosfilename>
<x>h<mpefilename>Z
&or<o>c <x>h<mpefilename>Z
&or<o>c<y>w<msdosfilename>
<x>h<mpefilename>Z
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o=0
o=1
o=2
o=3
o=4
o=5

a file to an HP3000 host under Windows
length in characters of MPE file name
default conversion option
text transfer, retain lines
binary transfer
text transfer, word wrap
backup MS- DOS file
restore HP file

default conversion option
text transfer, retain lines
binary transfer
text transfer, word wrap
backup HP file
restore MS- DOS file
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EC

Function

&opP

Print log file; see Logging sequences, above in this chapter

*s811^

Return TermTalk identity () function result string

&oS

Test status of MS92- specific escape sequences, returning a
string terminated by a carriage return. The first character
indicates whether the previous Ec&o... sequence was successful
with one of the following codes:
S Successful
F Failed
C Canceled by the user
X Sequence invalid
For file trnasfer sequences, this status character is followed by
the MS- DOS file name or NewWave object name.
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Color Terminal Escape Sequences
EC

Function

M e nu

*v<x>p

Select a palette 0<x<15

File

*v<method>m<int>a<int>b
<int>c<mix>I

Defines the color for one mix
method = 0 RGB
method = 11 HSL
int intensity for each component
a
red or hue value
b
green or saturation value
c
blue or luminosity value
mix 0 < mix < 7

File

*vL

Load a palette

File

*e<mix>B

Select color for background pen; 0<mix<7

*m<mix>X

Select color for primary pen; 0<mix<7

*m<mix>Y

Select color for secondary pen; 0<mix<7

*n<mix>X

Select color for graphics text pen;
0<mix<7

*m<mix>H

Select color for area boundary pen;
0<mix<7

*mH

Disable area boundary pen

*m<x>A

Select drawing mode x
0 = picture protect 4 = Jam2
1 = Clear1
5 = OR
2 = Jam1
6 = Complement2
3 = Complement1
7 = Clear2
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EC

Function

*m<x>W

Select predefined dithered color x
2 = Violet
3 = Brown
4 = Burnt orange
5 = Gold
6 = Lime
7 = Turquoise
8 = Red
9 = Green
10 = Blue

A - 24

M e nu

11 = White
12 = Black
13 = Lime
14 = Aqua
15 = Royal blue
16 = Fuschia
17 = Burnt sienna
18 = Pumpkin
19 = Gray brown

*m<x>,<y>,<z>V

Assigns densities <x>, <y>, and <z> to the
red, green, and blue color planes to select a
user- defined dithered color. <s>, <y>, and
<z> are values between 0.00 and 1.00,
converted by the terminal to the nearest
1/16th.

*v<x>D

Deletes a palette 0 < x < 15

*vE

Delete all palettes

&v<method>m
<fclr1>a<fclr2>b <fclr3>c
<bclr1>x<bclr2>y<bclr3>z
<pair>I

Assigns color to a color pair
method 0 for RGB, 1 for HSL
fclr1 red/hue value (foreground)
fclr2 green/sat value (foreground)
fclr3 blue/lum value (foreground)
bclr1 red/hue value (background)
bclr2 green/sat value (background)
bclr3 blue/lum value (background)
pair 0 < pair < 7

File

&v<pair>S

Select a color pair; 0 < pair < 7

File
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EC

Function

&f<key>k <pair>c
<column>xOL

Color a function key label
key
1 < key < 12
pair
0 < pair < 7
column 1 or 9

*v<mask><mix><pa
lette>^

Return palette and mix information. Mask is
converted to a binary number which selects from
the following list of status requests. Only the six
least significant digits are used.
mask - 32768 < mask < 32767
mix
0 < mix < 7
palette 0 < palette < 15
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M e nu

bit request
0
Does palette exist?

response
1 = yes/
2 = no

1

Is palette currently loaded?

1 = yes/
2 = no

2

Color selection method?

0 = RGB/
1 = HSL

3
4
5

Number of current palette?
R, G, and B values in mix?
H, S, and L values in mix?

0 - 15
n.nnnn for each
n.nnnn for each
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VT100 Escape Sequences
The following table lists the VT100 escape sequences recognized by
MS92, with keyboard, menu, and mouse equivalents, where available.

A - 26

EC

Function

Ke yboard

M e nu /
M ous e

[<x>A

Cursor up x spaces

UP arrow

Click desired spot

[<x>B

Cursor down x spaces

DOWN
arrow

Click desired spot

[<x>C

Cursor right x spaces

RIGHT arrow Click desired spot

[<x>D

Cursor left x spaces

LEFT arrow

[<r>;<c>H

Cursor position; row r,
column c

Click with mouse

H

Horizontal tab set

Margin/tab ruler

[<r>;<c>f

Horizontal and vertical
position; row r, column c

Click with mouse

D

Index

Click with mouse

M

Reverse Index

Click with mouse

E

Next line

Click with mouse

[g or [0g

Tab clear

Margin/tab ruler

[3g

Clear all tabs

Edit menu

7

Save cursor and attributes

Click desired spot
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Function

8

Restore cursor and attributes

[<tr><br>r

Set scrolling regions to top row tr, bottom
row br

[J or [0J

Erase from cursor to end of screen

[1J

Erase from beginning of screen to cursor

[2J

Erase from entire screen

[K or [0K

Erase from cursor to end of line

[1K

Erase from beginning of line to cursor

[2K

Erase entire line

(Bs

Set base character set to USASCII

(0s

Set base character set to line drawing

(As

Set base character set to UK

)Bs

Set alternate character set to USASCII

Settings
menu

)0s

Set alternate character set to line drawing

Settings
menu

)As

Set alternate character set to UK

Settings
menu

[<x>;...;<x>m

Display enhancements
x=0 attributes off
x=1 half- bright (substitute for bold)
x=4 underscore
x=5 blink
x=7 inverse video

[0c or [c

Identify terminal

[5n

Device status request (terminal)

[6n

Device status request (cursor position)

Z

Device Attributes

C

Hard reset
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M e nu /
M ous e

EC

C om m and
k ey
R

Utility
menu
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A - 28

Ke yboard

M e nu /
M ous e

EC

Function

=

Set keypad to application mode

>

Set keypad to numeric mode

[<x>;...;<x>q

Turn LEDs on/off
x=0 all LEDs off
x=1 1l on
x=2 L2 on
x=3 L3 on
x=4 L4 on

[<x>;...;<x>h

Set modes
x=20 New line mode
x=?1 Cursor keys in application mode
x=?3 132 column mode
x=?4 Smooth scrolling
x=?6 Relative origin mode
x=?7 Autowrap on

Settings
menu

[<x>;...;<x>l

Terminal reset modes
x=20 Linefeed mode
x=?1 Cursor keys in cursor mode
x=?3 80 column mode
x=?4 Jump scrolling mode
x=?6 Absolute origin mode
x=?7 Autowrap off

Settings
menu
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HP ANSI Escape Sequences
The following table lists the HP ANSI escape sequences recognized by
MS92, with keyboard, menu, and mouse equivalents where available. In
HP ANSI mode, MS92 also responds to all VT100 escape sequences.
EC

Function

Ke yboard

[<x>Z

Cursor backtab

SHIFT TAB

[<x>G

Cursor horizontal absolute

Click desired spot

[<x>E

Cursor next line

Click desired spot

[<x>F

Cursor preceding line

Click desired spot

[<x>d

Vertical position absolute

Click desired spot

[<x>e

Vertical position relative

Click desired spot

[>ls

Cursor home down

CTRL END

Press CTRL +
Home Up button

[>0s

Cursor home up

CTRL
HOME

Home Up button

[<x>U

Next page

PAGE
DOWN

Click scroll bar

[<x>V

Previous page

PAGE UP

Click scroll bar

[<x>T

Scroll down

CTRL
DOWN
arrow

Click down arrow

[<x>S

Scroll up

CTRL UP
arrow

Click up arrow

[<x>@

Insert character

[<x>A

Cursor up

[<x>P

Delete character(s)
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A - 30

EC

Function

Ke yboard M e nu

[<x>M

Delete line(s)

[<x>L

Insert line(s)

[0x or [1x

Request parameters from host

[5i

Print Controller mode on

[4i

Print Controller mode off

[<x>i

Media Copy

[?5i

Log bottom

Settings

[?4i

Log bottom off

Settings

&kl\

HP mode to ANSI mode

Settings

&k0\

ANSI mode to HP mode

Settings

[<x>;...;<x>h

Set modes
x=2 keyboard lock disabled
x=3 display functions on
x=4 insert char mode
x=>1 multi page mode
x=>2 memory locked

[<x>;...;<x>1

Reset modes
x=2 keyboard lock enabled
x=3 display functions off
x=4 replace char mode
x=>1 single page mode
x=>2 memory unlocked

M ous e
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Appendix B: Roman 8- and 7-Bit Character Sets

The terms 7-bit and 8-bit refer to the number of bits used to send,
receive, and represent characters. With 7 bits, characters whose ASCII
codes are 0 through 127 can be represented. With 8 bits, characters
whose ASCII codes are 0 through 255 can be represented.
In 8-bit ASCII mode, MS92’s default, you enter international characters
and various other symbols in the standard Macintosh style. On the U.S.
keyboard, this involves using the ALT/OPTION key together with one or
more other keys. On international keyboards, some characters can be
generated without using the ALT/OPTION key. To locate characters on
your particular keyboard, use the Key Caps desk accessory, and select
the HPScreen font from the Key Caps menu.
In 8-bit mode, MS92 translates characters typed into the corresponding
HP Roman 8 characters before transmitting them to the host. Characters
sent from the HP host computer are translated into the Macintosh character set as they are received. Thus, this mode maintains complete compatibility with HP implementation of the 8-bit character set while supporting
the familiar Macintosh keyboard.
When moving text to and from other applications, characters with codes
above 128 must be converted. MS92 performs this conversion automatically. Some Roman 8 characters have no equivalent in the ANSI set, and
some ANSI characters have no equivalent in Roman 8. They are represented by the DEL character (decimal value 127) in MS92.
The chart below shows Roman 8 international characters, their hexadecimal and decimal values, and how the character is produced on a
Macintosh running MS92.
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char

he x

de cimal

un- defined

A0

160

À

A1

161

ALT/OPTION ' A

Â

A2

16 2

ALT/OPTION t

È

A3

163

ALT/OPTION r

Ê

A4

164

ALT/OPTION 2

Ë

A5

165

ALT/OPTION }

Î

A6

166

ALT/OPTION 8

Ï

A7

16 7

ALT/OPTION 7

´

A8

168

ALT/OPTION e
ALT/OPTION e

`

A9

169

ALT/OPTION V

ˆ

AA

170

ALT/OPTION i
ALT/OPTION i

¨

AB

171

ALT/OPTION u
ALT/OPTION u

~

AC

172

ALT/OPTION /

Ù

AD

173

ALT/OPTION ,

Û

AE

17 4

ALT/OPTION .

It alian Lira symbol

AF

175

ALT/OPTION =

-

B0

17 6

ALT/OPTION _

un- defined

B1

17 7

un- defined

B2

178

o

B3

17 9

ALT/OPTION *

Ç

B4

18 0

ALT/OPTION C
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B-4

char

he x

de cimal

M ac ke ys

ç

B5

181

ALT/OPTIONS c

Ñ

B6

182

ALT/OPTIONS n N

ñ

B7

183

ALT/OPTIONS n n

¡

B8

184

ALT/OPTIONS 1

¿

B9

18 5

ALT/OPTIONS ?

¤

BA

186

ALT/OPTIONS 5

£

BB

187

ALT/OPTIONS 3

¥

BC

18 8

ALT/OPTIONS ]

§

BD

189

ALT/OPTIONS 6

ƒ

BE

190

ALT/OPTIONS f

¢

BF

191

ALT/OPTIONS 4

â

C0

192

ALT/OPTIONS i a

ê

C1

193

ALT/OPTIONS i e

ô

C2

194

ALT/OPTIONS i o

û

C3

19 5

ALT/OPTIONS i u

á

C4

19 6

ALT/OPTIONS e a

é

C5

197

ALT/OPTIONS e e

ó

C6

198

ALT/OPTIONS e o

ú

C7

19 9

ALT/OPTIONS e u

à

C8

200

ALT/OPTIONS ` a

è

C9

201

ALT/OPTIONS ` e

ò

CA

202

ALT/OPTIONS ` o

ú

CB

203

ALT/OPTIONS ` u

ä

CC

204

ALT/OPTIONS u a

ë

CD

205

ALT/OPTIONS u e

ö

CE

206

ALT/OPTIONS u o

ü

CF

207

ALT/OPTIONS u u
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char

he x

de cimal

M ac ke ys

Å

D0

208

ALT/OPTION A

î

D1

209

ALT/OPTION i i

Ø

D2

210

ALT/OPTION o

Æ

D3

211

ALT/OPTION "

å

D4

212

ALT/OPTION a

í

D5

213

ALT/OPTION e i

ø

D6

214

ALT/OPTION o

æ

D7

215

ALT/OPTION '

Ä

D8

216

ALT/OPTION u A

ì

D9

217

ALT/OPTION' i

Ö

DA

218

ALT/OPTION u o

Ü

DB

219

ALT/OPTION u U

É

DC

220

ALT/OPTION g

ï

DD

221

ALT/OPTION u i

ß

DE

222

ALT/OPTION s

Ô

DF

223

ALT/OPTION y

Á

E0

224

ALT/OPTION m

Ã

E1

225

ALT/OPTION n A

ã

E2

226

ALT/OPTION n a

Ð

E3

227

ALT/OPTION d

d wit h st rok e

E4

228

ALT/OPTION w

Í

E5

229

ALT/OPTION P

Ì

E6

230

ALT/OPTION p

Ó

E7

231

ALT/OPTION b

Ò

E8

232

ALT/OPTION z

Õ

E9

233

ALT/OPTION n

õ

EA

234

ALT/OPTION o
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B-6

char

he x

de cimal

M ac ke ys

Š

EB

235

ALT/OPTION l

š

EC

236

ALT/OPTION v

Ú

ED

237

ALT/OPTION x

Ÿ

EE

238

ALT/OPTION j

ÿ

EF

239

ALT/OPTION u y

Þ

F0

240

ALT/OPTION {

þ

F1

241

ALT/OPTION ;

un- defined

F2

242

un- defined

F3

243

un- defined

F4

244

un- defined

F5

245

-

F6

246

ALT/OPTION -

¼

F7

247

ALT/OPTION Q

½

F8

248

ALT/OPTION q

a

F9

249

ALT/OPTION 9

o

FA

250

ALT/OPTION 0

«

FB

251

ALT/OPTION \

n

FC

252

ALT/OPTION [

»

FD

253

ALT/OPTION |

±

FE

254

ALT/OPTION +

un- defined

FF

255
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When you select a 7-bit language in the Keyboard/Character Set configuration box, only a subset of international characters is available and a
special translation process is required to access these characters. MS92
performs this translation by substituting from the chart below according
to the language you have configured.
Decimal value

35

39

64

91

92

93

94

96

123 124 125 126

US ASCII key

#

'

@

[

\

]

^

`

{

|

}

~

Swedish/Finnish

#

,

É

Ä

Ö

Å

Ü

é

ä

ö

å

ü

Danish

§

´

@

Æ

Ø

Å

^

`

æ

ø

å

¨

French

£

,

à

°

ç

§

^

`

é

ù

è

¨

German

£

´

§

Ä

Ö

Ü

^

`

ä

ö

ü

ß

United Kingdom

£

,

@

[

\

]

^

`

{

|

}

~

Spanish

#

´

@

¡

Ñ

¿

°

`

{

ñ

}

¨

Norwegian

#

´

@

Æ

Ø

Å

^

`

æ

ø

å

¨

To enter an international character in HP 7-bit style, press the US ASCII
key associated with that character, as shown in the preceding chart.
For example, assume that MS92 is configured for 7-bit French operation.
♦

If you press the # key on a Macintosh U.S. keyboard, or the £ key on
a Macintosh French keyboard, or if a character with decimal value
35 is sent to the terminal by the host, the £ symbol is displayed.

♦

If that character is then placed in a file on the HP3000, and that file
is listed on a terminal operating in USASCII mode, the character is
displayed as a #.

♦

On a Danish terminal, it is displayed as a §.

♦

If it is copied to the clipboard, it is copied as a #, since that is the
standard ASCII character associated with the decimal value 35.

Thus in 7-bit mode, international characters “revert” to the corresponding US ASCII characters when copied to the clipboard. This does not
occur in 8-bit mode since each 8-bit HP Roman 8 character is mapped
onto the corresponding character in the Macintosh character set.
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The chart below shows control characters, their hexadecimal value, and
how the character is produced on a Macintosh running MS92. Control
characters can also be generated using the control bar at the top of the
screen.
If you have an older Macintosh keyboard without a CTRL key, the ALT/
OPTION key can be used as the HP CTRL key. However, there are
certain cases where you must press both ALT/OPTION and SHIFT in
combination with the designated character to generate a control character.
♦

The caret (^), used to generate an RS character (record separator),
and the underscore ( _ ), used to generate a US character (unit
separator), are both shifted characters. For example, to generate an
RS, you hold down both ALT/OPTION and SHIFT while you press
the 6.

Certain keys on the United States keyboard are “delayed” when pressed
in combination with the ALT/OPTION key. Instead of being transmitted
immediately, these characters are retained until a second key is pressed.
(This is because these characters are used to produce diacritical marks
over the next character entered.)
The control characters affected by this are ALT/OPTION e, ALT/OPTION u, ALT/OPTION i, ALT/OPTION n, and ALT/OPTION `. To
generate these characters, you must either hold down both the ALT/
OPTION key and the SHIFT key while you press the designated character, or just hold down the ALT/OPTION key while you press the designated character twice.
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char

he x

de cimal

M ac ke ys

NUL

00

0

CONTROL @

SO H

01

1

CONTROL A

STX

02

2

CONTROL B

ETX

03

3

CONTROL C

EOT

04

4

CONTROL D

ENQ

05

5

CONTROL E

ACK

06

6

CONTROL F

BEL

07

7

CONTROL G

BS

08

8

CONTROL H

HT

09

9

CONTROL I

LF

0A

10

CONTROL J

VT

0B

11

CONTROL K

FF

0C

12

CONTROL L

CR

0D

13

CONTROL M

SO

0E

14

CONTROL N

SI

0F

15

CONTROL O

DLE

10

16

CONTROL P

DC1

11

17

CONTROL Q

DC2

12

18

CONTROL R

DC3

13

19

CONTROL S

DC4

14

20

CONTROL T

NAK

15

21

CONTROL U

SYN

16

22

CONTROL V
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char

he x

de cimal

M ac ke ys

ETB

17

23

CONTROL W

CAN

18

24

CONTROL X

EM

19

25

CONTROL Y

SUB

1A

26

CONTROL Z

ESC

1B

27

CONTROL [

FS

1C

28

CONTROL \

GS

1D

29

CONTROL ]

RS

1E

30

CONTROL ^

US

1F

31

CONTROL _
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APPENDIX D: APPLEEVENTS

AppleEvents provide a way for Macintosh applications to communicate
with each other. For example, AppleEvents are used by the Finder under
System 7 to open applications and documents, to print files, and to quit
applications.
MS92 can receive but not send AppleEvents. In particular, MS92 allows
any Mac application that can send AppleEvents to run a TermTalk script.
To take advantage of this capability, consult the documentation for the
application from which you want to send the AppleEvent.
The types of events MS92 can receive are:

D-2

♦

Open Application

♦

Open Documents

♦

Print Documents

♦

Quit Application

♦

Do Script
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Syntax
To send an AppleEvent, send the class and ID for the particular event and
any required parameters. Class and ID are represented by four characters,
case-sensitive constants. The parameters are specified as internal data
structures and have corresponding types. These types are also represented by four character constants. The application receiving the event is
responsible for retrieving the parameters and converting them to the
correct internal format.

Open Application
Event Class: aevt
Event ID: oapp
Parameters: none
Notes: Runs MS92. This AppleEvent is sent to an application by the
Finder when the user double clicks the application’s icon.

Open Documents
Event Class: aevt
Event ID: odoc
Parameter Type: list
Contents: list of documents to open
Notes: The Open Documents AppleEvent can open at most two documents: one MS92 file and one script file. If a script file is specified, it is
opened in MS92’s script editor window.
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Print Documents
Event Class: aevt
Event ID: pdoc
Parameter Type: list
Contents: list of documents to open
Notes: MS92 can print only text type documents.

Quit Application
Event Class: aevt
Event ID: quit
Parameters: none
Notes: Terminates MS92.

Do Script
Event Class: misc
Event ID: dosc
Parameter Type: TEXT or alis
Contents: If TEXT, contains TermTalk commands. If alis, contains a list
of scripts to execute.
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Capture File
If you call your Minisoft support representative with a technical question
involving the interaction of MS92 with one of your host applications,
you may be asked to create a capture file to be used for diagnostic
purposes. When MS92’s capture facility is turned on, all data and control
sequences transmitted from the terminal to the host and from the host to
the terminal are intercepted and written to a file called MS92 Capture
File.
To turn on MS92’s capture facility, use the CTRL + SHIFT +
SPACEBAR key combination. A dialog box will appear with the following message:
“This keystroke turns on the Session capture diagnostic system. All I/O
will be logged to the Session Capture File.”
If a file called MS92 Capture File already exists, it is overwritten.
To turn off the capture facility, use the same key combination, CTRL +
SHIFT + SPACEBAR. A message confirming that capture is disabled is
displayed.
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Error Messages
This section provides an alphabetical listing of error and warning messages that may appear while you are using MS92. These messages can
help you determine if you have made an error or if there has been a
malfunction in your system.

A file system error has occurred. (see list below)
There is a problem with the disk or the files on the disk.
Check that the disk is not full or corrupted.
♦

Unable to flush volume.

♦

Unable to set file marker.

♦

Unable to set file info.

♦

Unable to get file info.

♦

Unable to set end of file.

♦

Unable to access file.

♦

Unable to create file.

♦

Unable to open file.

♦

Unable to close file.

♦

Unable to write file.

♦

Unable to read file.

♦

File directory is full.

♦

Disk is full.

♦

Nonexistent File or Volume.

♦

Unexpected end-of-file.

♦

Attempted to position prior to start of file.

♦

System heap is full.

♦

To many files are open.
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♦

File or Volume is locked.

♦

One or more files are open.

♦

A file with this name already exists.

♦

Writing to this file is not allowed.

♦

Nonexistent access path.

♦

Volume is not on-line.

♦

Volume is already mounted and on-line.

♦

Not a Macintosh disk.

♦

External file system.

♦

Problem during rename.

♦

Bad directory Reinitialize volume.

♦

Disk I/O error.

♦

Bad File or Volume name.

♦

File is not open.

A printer spool file has just been created. You may print the file, save the
file, or discard the file.
This message occurs when a printer spool file is created by logging
to a spool file.
Select the button for the desired action.

A printer spool file is being created. After logging is complete, print the
file by selecting ‘Print Spooled’ from the Log menu.
A printer spool file has been created by logging to a spool file.
No immediate action is required until you want the spooled text to be
printed. Print the file by selecting Print Spooled from the Log menu.
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Are you sure you want to quit?
This message is displayed when Command Q is pressed to ensure
that you didn’t accidentally press the keys.
Press the Quit button or Cancel.

Cannot access HP x000 file.
You have attempted to access an nonexistent host file during a file
transfer.
Enter a valid existing file name.

Cannot locate Tymlink.
MS92 had a problem finding the Tymlink program during installation.
Make sure the MS92 master disk is in a disk drive.

Cannot open Tymlink program file on a mounted disk. Be sure to start
up from the original MS92 master disk
An error has been encountered opening the Tymlink program.
Insert the MS92 master disk that contains the Tymlink file.

Cannot open UPLOAD.C file on a mounted disk. Be sure to start up
from the original MS92 master disk.
An error occurred opening the UPLOAD.C file.
Insert the MS92 master disk containing the UPLOAD.C file.

Cannot position file Tymlink.
There is a problem with the Tymlink disk.
Copy Tymlink to another floppy disk and restart the installation.
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Cannot rewind file UPLOAD.C.
There is a problem with the Tymlink disk.
Copy Tymlink to another floppy disk and restart the installation.

Changing the number of screens will destroy the current contents of
display memory.
The contents of display memory cannot be saved during this operation.
Reply OK if you wish to continue with the action, otherwise select
Cancel.

Disconnect... only works for Hayes-compatible modems. If you are using
a non-Hayes-compatible modem, you must type in the hangup command
yourself.
An attempt has been made to disconnect, but the modem is not
configured as a Hayes compatible.
Enter the hangup command directly to your non-Hayes modem,
rather than using Disconnect.

Display memory is full and Memory Lock is on. Turn Memory Lock off
if you need to continue interactive operations.
The Memory Lock display overflow protection is enabled. This means
that memory lock is enabled on row 1 so that no lines can be scrolled
off the screen.
Turn Memory Lock off if this is not desirable, or home up and clear
the screen to reuse existing memory.
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File already exists. OK to replace existing file?
An attempt has been made to save over an existing file.
If the original file can be deleted, reply OK, otherwise select Cancel
and enter a new name for the file being saved.

Getting the requested memory.
This message appears when you change the number of screens or
columns in the Terminal Settings... dialog box.
No action is required.

HP x000 file already exists. OK to replace existing file?
An attempt has been made to save over an existing host file.
If the original file on the host can be deleted, reply OK, otherwise
select Cancel and enter a new name for the file to be transferred.

Installation of HPx000 link program failed.
Tymlink could not be installed.
1) Check that your terminal is configured to 8-bit, no parity, one stop
bit, and TERMTYPE 10.
2) Lower the baud rate and retry the installation.
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Memory Allocation Error.
Fatal memory error.
Must quit the program.
Give more memory to MS92 if possible.
MS92 has encountered a shortage of memory from which it cannot
recover.
Quit MS92 and, if possible, increase the amount of memory allocated
to MS92 using Get Info from the File menu of the Finder.

Neither UMODEM nor a C Compiler is available. Please call your
supplier for installation assistance.
There is no way for MS92 to automatically install Tymlink.
Call your supplier. File transfers with this Unix host will not be possible until that time.

Not enough memory for x screens. Only y screens were created.
This message appears when you change the number of screens or
columns in the Terminal Settings... dialog box and not enough
memory is available to fulfill the request.
No action is required. If you need the extra screens or columns,
increase the amount of memory allocated to MS92 using Get Info
from the File menu of the Finder.

Not enough memory to complete the operation.
MS92 has encountered a shortage of memory. The operation you
requested (usually a Copy or Paste) is not being performed.
Quit MS92 and increase the amount of memory allocated to the
program using Get Info from the File menu of the Finder.
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Please insert the MS92 Master disk and open Tymlinkxxxx/xxx.
MS92 is trying to install Tymlink, but could not find the program.
Insert the MS92 master disk and open the requested Tymlink program.

Please insert the MS92 Master disk and open UPLOAD.C.
The file UPLOAD.C file could not be found during the installation of
Tymlink.
Insert the MS92 master disk and open UPLOAD.C.

Printer error.
An error has occurred during a printing operation.
Please check the printer and reconfigure MS92 printing.
Something went wrong during printing.
Check that the printer is properly attached and is selected with the
Chooser. Check the MS92 printing configuration in the Logging
Settings dialog box.

Read error on file Tymlink.
There is a problem with the Tymlink disk.
Copy Tymlink to another floppy disk and restart the installation.

Read error on file UPLOAD.C.
There is a problem with the Tymlink disk.
Copy Tymlink to another floppy disk and restart the installation.
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Receive file operation did not complete successfully.
The cause of the problem will either be presented in another dialog,
or is unknown by MS92.
1. Try again.
2. Choose Do Command from the Script menu. Select the set
blocksize command from the scrolling list. In the edit box, change
1024 to 256. Click the Do button.
3. Choose File Transfer from the Settings menu. Enable Use substitutes for control characters and/or Use substitutes for 8-bit characters.

Send file operation did not complete successfully.
The cause of the problem will either be presented in another dialog,
or is unknown by MS92.

Sorry, a FATAL error has occurred in MS92. Unable to get HPScreen
font.
This error indicates a problem with the MS92. program file.
Replace your copy of MS92 with a new copy.

Sorry, a FATAL error has occurred on the serial port.
A problem has occurred with the serial port on the Macintosh.
Check that no other programs that use the serial port are active.
Restart your Macintosh and try opening MS92 again.
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Sorry, unable to run Desk Accessory because of insufficient memory.
This message occurs when trying to open a desk accessory and not
enough memory is available.
Quit any desk accessories already running and try again.

The file already exists. You may Cancel the operation, continue and
overwrite, specify a new file name, or append to the existing file.
An attempt has been made to log to an existing text file.
Select the button for the desired action.

There is a problem with the modem. Check your connections and try
turning the modem off and on again and then reselect Connect Using
Modem.
An attempt has been made to connect to a host using a modem, but
the modem is not responding.
Check that the modem is correctly connected to the Macintosh and is
turned on. Also check that the modem is Hayes compatible.

There is no phone number to dial. Use the Configure Modem... menu
item to enter the phone number. Then select the Connect... menu item
again.
You have selected Modem as your Connection type but failed to enter
a phone number.
Enter a phone number in the Connection Settings box and try to
connect again.
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The version of Tymlink on your host is newer than the one expected by
MS92. You should consider updating your copy of MS92 to the latest
version.
MS92 has detected that the copy of Tymlink being used is newer than
the version of MS92 currently running.
Normally the file transfer may be completed without any problem, but
you may want to get the latest copy of MS92 from your supplier.

The version of Tymlink on your host is not the one expected by MS92.
You may proceed with the transfer, but some options may be unavailable.
MS92 has detected that the copy of Tymlink being used is older than
the version that MS92 expects.
The file transfer can be completed without any problem, but the
version of Tymlink shipped on the disk with your copy of MS92 should
be installed. See Chapter 9 for instructions.

This configuration or settings file is an old format file. It will be opened
as ‘untitled’ so you may resave it as a new file.
The settings file you just opened was created by an older version of
MS92. It can be used.
Resave the file under the current version of MS92.

This configuration or settings file is not from MS92 version 2 or above.
Please reconfigure and resave the settings.
The settings file you just opened was created by an older version of
MS92. It cannot be opened.
Reconfigure your settings and save under the current version of
MS92.
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UMODEM is not available; looking for a C compiler.
MS92 cannot find UMODEM on the system to use for the installation,
so it searches for a C compiler to compile the UPLOAD.C program.
No user action is required.

UMODEM is not functioning properly.
The installation has failed due to problems with the host UMODEM
program.
Make sure you have a working version of UMODEM on your Unix
host, and restart the installation.

Unable to run HP x000 link program.
A file transfer has begun and the Tymlink program is unable to run.
Make sure the name and location of the Tymlink program are correct
in the File Transfer Settings dialog box. Make sure you are logged on
correctly and connected to the host.
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File Transfer
Some of the messages you may encounter during file transfer are discussed below.
File error detected on the HP9000
The HP9000 file you specified cannot be created. You may be out of disk
space, have incorrect security access, or have misspelled file name, disk
drive, or directory.
Macintosh (or HP3000 or HP9000) file already exists
A file with the name you specified already exists on the target disk. Click
Yes in this box to replace the existing file. Click No to rename the file
being transferred or to cancel the transfer.
Invalid file reference (FSERR 54)
The host file name specified does not follow HP3000 naming conventions.
Nonexistent permanent file (FSERR 52)
The HP host file you specified does not exist.
Out of disk space (FSERR 46)
There is not enough space on the host to build the file you are trying to
send.
Path name not found
The directory specified doesn’t exist. Cancel and repeat the operation
with a legal filename.
Privileged file violation (FSERR 45)
This usually means you tried to copy or build an IMAGE or
TurboIMAGE database. MS92 does not support transfers of IMAGE or
TurboIMAGE files.
Security violation (FSERR 93)
You don’t have the proper capabilities to open, build, or save a file in the
group and account specified.
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The version of Tymlink on the HP3000 (or HP9000) is older than the
one expected by MS92
The latest version of Tymlink has not been installed on the host. You may
proceed with the transfer, though some options may not be available or
may work differently. Ask your system manager to install the version of
Tymlink requested in the alert message.
Unable to run HP3000 (or HP9000) link program
Make sure you are logged on. Make sure Tymlink is installed on the host
system in the group and account where MS92 expects it to be. Do this by
choosing File Transfer from the Settings menu and checking the Startup
Sequence.
For HP3000 file transfers, if there is a long pause after which the operation terminates with this message, it may be that your host does not
supply the DC1 character used for pacing. Choose File Transfer from the
Settings menu and try unchecking the Host provides DC1 pacing option.
Feel free to copy Tymlink into several different groups on your HP3000
if multiple copies are needed.
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A
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AppleEvents D-2
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files 8-9
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